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Welcome to GIFTS Alta

This publication includes all the information you need to install or 
upgrade your GIFTS Alta system—including optional modules like 
the Internet Grant Application Module™ 5.

Clients who have purchased GIFTS Connections™ products like 
MyGIFTS™ and ReviewerCONNECT™ should also refer to the 
GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation and 
Technical Reference Guide.

In This Chapter
Contents of the MicroEdge GIFTS Alta Download .................ix

Overview of the Installation or Upgrade Process.....................xi

Conventions Used in This Manual ........................................ xiv

Using MicroEdge Documentation......................................... xvi

Using the Documentation ................................................... xviii

Maintenance and Support Program....................................... xix
viii



Contents of the MicroEdge GIFTS Alta 
Download

Depending on your current GIFTS Alta installation configuration, the 
MicroEdge download for GIFTS Alta can be used to install (or upgrade to) 
GIFTS Alta 1.7, IGAM 6.0, and GIFTS Connections 3.6. These products are 
described as follows.

GIFTS Alta 1.7

GIFTS Alta is a robust system for tracking proposals and grants from the 
time requests are received through closure. You can retrieve and classify 
requests, generate letters, manage contacts, schedule and monitor activities, 
maintain complete organization histories, track payments, and much more. 
Additional modules allow you to expand your GIFTS Alta system to track 
different kinds of data and giving.

GIFTS Alta is the foundation of the other MicroEdge products described 
here.

Internet Grant Application Module 6.0

IGAM enables grantmakers to accept grant applications and proposals 
through the Internet and allows grantmakers to create requirement forms 
for grantee reporting. IGAM can increase the quality of the grant 
submissions you review and significantly reduce the work required to 
process them. It can save time and lower your operating costs.

GIFTS Connections 3.6

The GIFTS Connections server (GCS) makes it possible to access and edit 
GIFTS Alta data through a web browser. The server retrieves information 
from your GIFTS Alta database and formats it for display in a web page.

In turn, GCS can also receive data from users connecting through the 
Internet and save it to GIFTS Alta. This allows users to connect to your 
ix Contents of the MicroEdge GIFTS Alta Download



GIFTS Alta system from anywhere, while your organization maintains a 
single database.

GCS is the hub of the GIFTS Connections suite of products. With the server 
translating data to browser-ready form—and back again—GIFTS 
Connections products designed for specific audiences are ready to be added:

MyGIFTS MyGIFTS is designed to give members and employees of your 
organization convenient and versatile access to GIFTS Alta from remote 
locations. Whether connecting through an intranet or over the Internet, 
your users have a way to interact with GIFTS Alta through their web 
browser.

ReviewerCONNECT ReviewerCONNECT is designed to give reviewers 
convenient access to your proposals from remote locations. Internal and 
external reviewers can provide instant feedback on proposals by editing and 
submitting review data through their web browsers.
Contents of the MicroEdge GIFTS Alta Download x



Overview of the Installation or Upgrade 
Process

Although the MicroEdge GIFTS Alta Installation download will contain all 
of the data necessary to install these different systems, some products are 
installed in separate procedures. This section describes the order in which 
you must install these products.

!
Caution: Before upgrading, you should always make sure the backup of your 
database is up to date.

Part 1: Installing or Upgrading GIFTS Alta and 
IGAM

The first part of the installation process is to install or upgrade GIFTS Alta 
and the Internet Grant Application Module (if purchased). These two 
products are installed or upgraded simultaneously, along with any optional 
GIFTS Alta modules.

Before installing or upgrading GIFTS Alta and IGAM, you should read 
“Installation Options and Requirements” on page 1. This chapter details the 
GIFTS Alta configuration options and describes the storage, performance, 
and installation considerations for each of these configurations.

If you’re installing GIFTS Alta for the first time, choose the chapter 
containing instructions for your standalone or network setup:

Chapter Summary

“New GIFTS Alta Standalone 
or File Server Installation” on 
page 23

Contains installation instructions for two different 
environments: a standalone system on a single 
computer, or a file server system with a GIFTS Alta 
file server and one or more workstations.

“New Microsoft SQL Server 
Installation” on page 37

Describes how to install a multi-user GIFTS Alta 
system with a Microsoft SQL Server database.
xi Overview of the Installation or Upgrade Process



If you’re upgrading to GIFTS Alta from GIFTS 6.4 or later, or a previous 
version of Alta, follow the instructions from the appropriate Upgrade 
chapter:

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

If your configuration DOES NOT include MyGIFTS or 
ReviewerCONNECT, your installation is complete after following the 
instructions referenced above.

“New Oracle Server 
Installation” on page 59

Describes how to install a multi-user GIFTS Alta 
system with an Oracle server database.

“New Installation of GIFTS 
Alta with Citrix Presentation 
Server” on page 83

Describes how to install GIFTS Alta on a computer 
running Windows Terminal Services to provide user 
access to GIFTS Alta through Citrix Presentation 
Server™.

Chapter Summary

“Upgrading a GIFTS Alta 
Standalone Workstation or 
File Server” on page 99

Contains upgrade instructions for two different 
GIFTS Alta setups: a standalone workstation, and a 
file server network.

“Upgrading GIFTS Alta Client/
Server Installations” on 
page 113

Describes how to upgrade GIFTS Alta in the SQL 
Server or Oracle server environment.

“Upgrading GIFTS Alta with 
Citrix Presentation Server” on 
page 127

Describes how to upgrade GIFTS Alta on a computer 
running Windows Terminal Services, providing user 
access to GIFTS Alta through Citrix Presentation 
Server™.

Chapter Summary
Overview of the Installation or Upgrade Process xii



If your configuration includes MyGIFTS/ReviewerCONNECT, it must be 
version 3.6 or later to be compatible with GIFTS Alta 1.7 and IGAM 6.0.

!
Caution: Use of a version of MyGIFTS/ReviewerCONNECT prior to 3.6 with 
GIFTS Alta 1.7 and/or IGAM 6.0 may cause compatibility issues.

If you have an earlier version of MyGIFTS/ReviewerCONNECT, please 
upgrade to version 3.6 which is included with the GIFTS Alta upgrade 
download.

For information about installing or upgrading GIFTS Connections, please 
refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation 
and Technical Reference Guide.
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Conventions Used in This Manual
Before you read this manual, it is helpful to familiarize yourself with the 
conventions used within. Doing so will enhance the usefulness of the 
documentation.

Note that the name “GIFTS Alta” is used generically to refer to any 
configuration of the system.

Procedural and Typographic Conventions

This manual uses the following conventions to clarify the procedures and 
tasks it describes:

❖ Important procedures are always given as a numbered set of tasks. 

❖ Check marks indicate a checklist of general items or tasks.

❖ Characters given in this font are examples of data that you should enter, 
such as the directory path to a file. 

❖ Data elements within the GIFTS Alta system are presented with an Initial 
Capital Letter. For example, the word “request” is capitalized when it is 
used to refer to a Request record within GIFTS Alta.

Different Types of Notes

When appropriate, notes provide additional information or warnings that 
may apply to you. This manual uses four types of notes. Each type of note 
serves a unique purpose:

Note: A note with this format and the heading “Note” provides information 
that applies to some users. Notes apply to special situations. For example, a 
Note might explain minor differences in setup procedures among network 
and standalone systems.

Important: A note with this format and the heading “Important” provides 
information that applies to all users. This type of note provides information 
that is essential to the completion of a task.
Conventions Used in This Manual xiv



!
Caution: A note with this format and the heading “Caution” provides 
important information that applies to all users. Pay special attention to these 
notes.

Tip: A note with this format and the heading “Tip” provides useful 
information that applies to most users. Although Tips are not essential to 
the completion of a task, they provide alternative methods, shortcuts, or 
special applications relating to the procedures in the text. 
xv Conventions Used in This Manual



Using MicroEdge Documentation
The GIFTS Alta documentation provides step-by-step procedures and 
reference information on GIFTS Alta features. These manuals assume you 
have a working knowledge of your operating system and its conventions, 
including how to use a mouse and standard menus.

Tip: The MicroEdge PowerME portal, available on the MicroEdge website, 
provides quick and easy access to up-to-date technical information about 
MicroEdge products, including the information in your printed manuals.

GIFTS Alta includes the following documentation:

GIFTS Alta Quick Starter Guide This guide is meant for previous users of 
GIFTS who wish to learn about the new features of GIFTS Alta. It assumes 
working knowledge of basic GIFTS functionality.

GIFTS Alta User’s Guide Describes how to use GIFTS Alta to manage your 
giving: how to enter data, search for data, run reports, and other 
grantmaking tasks.

GIFTS Alta Installation and Technical Reference Guide Contains system 
requirements and detailed installation/upgrade procedures.

Note: This is the only printed guide you will receive. The rest of the 
documentation is available in .pdf format only. 

Using GIFTS Alta Reports Describes how to run reports from the GIFTS Alta 
Report Library. Includes a variety of sample reports for GIFTS Alta and 
Employee GIFTS.

GIFTS Alta Administrator’s Guide Describes how to set up and maintain your 
GIFTS Alta system. This manual, which also describes how to use the 
optional GIFTS Alta Customizer, should be read by the person within your 
organization designated as the GIFTS Alta Administrator.
Using MicroEdge Documentation xvi



Related Documentation

If you use optional GIFTS Alta modules such as Employee GIFTS or the 
Internet Grant Application Manager, you will receive additional 
documentation in .pdf format.

Internet Grant Application Manager User’s Guide Describes how to review 
grant applications that have been submitted through the Internet and how 
to create grant applications and requirement forms.

Import Module User’s Guide Describes how to import data from external 
systems into GIFTS Alta.

MyGIFTS and ReviewerCONNECT Installation and Technical Reference Guide

Includes system requirements and detailed installation/upgrade 
procedures.

MyGIFTS User’s Guide Describes how to get the most out of your online 
GIFTS data access using MyGIFTS.

MyGIFTS Administrator’s Guide Describes how to set up GIFTS Connections 
and MyGIFTS to give users online access to GIFTS Alta data.

Reviewers Module and ReviewerCONNECT User’s Guide Describes how to 
extend the functionality of the GIFTS Alta Reviewers Module by granting 
reviewers online access to their reviews.

For more information on the resources available to you as a MicroEdge 
client, please refer to the MicroEdge Client Resource Guide.
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Using the Documentation
MicroEdge includes the GIFTS Alta documentation with your download in 
Portable Document Format (PDF). To view these files, you will need the 
Adobe® Reader, which is available for free from Adobe Systems, Inc. at 
http://www.adobe.com.

You can print out selected pages, sections, chapters, or the entire book. You 
can also install the files on your computer or network so you can access 
them online, and take advantage of features such as a “hot” table of 
contents, index, and cross-references within books.

Tip: You can also obtain PDF copies of the documentation from the 
MicroEdge PowerME site’s Content area. 

Note: The Adobe Reader’s other features are described in the Reader’s online 
Help. Note that MicroEdge does not provide technical support for the Adobe 
Reader. We cannot assist you with the installation, configuration, or use of 
this product. 
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Maintenance and Support Program
Members of MicroEdge’s Maintenance and Support Program receive 
unlimited telephone consultation on the use of the software, assistance in 
error isolation and correction, software updates, and prompt resolution of 
any available problem solutions relating to the currently supported versions 
of GIFTS Alta.

Our Technical Support staff are available Monday through Friday, 8:00 A.M. 
to 8:00 P.M. Eastern time. You may contact MicroEdge's Technical Support 
Specialists as follows:

Members may also search our library of documentation and technical 
bulletins on the MicroEdge PowerME portal.

http://microedge-powerme-portal.force.com/Login

For details about our support policies, please refer to the MicroEdge Client 
Resource Guide. 

If you have any questions regarding the Maintenance and Support Program, 
please call 1-800-899-0890 and ask for a Client Account Representative.

You can also access our list of Account Representatives directly on our 
website to contact them directly.

http://www.microedge.com/About/ContactUs/AccountReps.aspx

Phone 1-877-704-3343

Fax (212) 757-1784

Email helpdesk@microedge.com

Internet Login to PowerME and click Cases
xix Maintenance and Support Program



1 Installation
Options and

Requirements
This chapter details the standalone, file server, and client/server 
configuration options of GIFTS Alta—and describes the storage, 
performance, and installation considerations for each of these 
configurations.

In This Chapter
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Installation Options and Requirements1

Configuration Options

The following implementations of GIFTS Alta are available:

❖ A standalone version for a single workstation.

❖ A file server version for concurrent user access on a local area network 
(LAN).

❖ A high-performance client/server version for organizations with remote 
sites and a large number of concurrent users. The client/server versions 
are compatible with Microsoft SQL Server or Oracle server.

Note: With any of these configurations, you can install GIFTS Alta on a 
computer running Windows® Terminal Services with Citrix® Presentation 
Server™ to make your GIFTS Alta applications available from nearly any 
computer connected to your network or the Internet.

The following diagrams illustrate possible standalone, file server, and client/
server configurations. These diagrams indicate the network location of the 
GIFTS Alta program files, database, and templates—as well as the location 
of other supporting programs and files. Knowledge of this design facilitates 
troubleshooting on network systems. 

Note: The number of concurrent users you may have is limited by the 
number of user licenses you have purchased.

In general, each box in these diagrams represents a computer, and lists the 
GIFTS Alta components and supporting components resident on it. Possible 
exceptions or alternative configurations are listed with each example. 
2 Configuration Options



Installation Options and Requirements 1

Standalone System

On standalone (local) systems, all GIFTS Alta components reside on a single 
workstation.

Optional Setup: Using Windows Terminal Services with Citrix Presentation 
Server, you can provide multi-user access to a standalone system.

Sample File Server Configuration

On file server systems, the GIFTS Alta database resides on a file server and is 
accessed by one or more GIFTS Alta workstations. Please note the 
following:

❖ By default, the GIFTS Alta program files (EXEs) are installed on the file 
server. It is also possible to install these files on your workstations for 
increased performance.

❖ This example shows computers that access a GIFTS Alta workstation 
using Citrix Presentation Server. For information about the software 
required to connect through the Presentation Server, please refer to 
documentation provided by Citrix. MicroEdge cannot provide support for 
Citrix products.

❖ In file server systems running on a peer-to-peer network, a single computer 
can act as both the file server and as a workstation. This workstation/file 
server is known as the master workstation. For detailed instructions for 
installing GIFTS Alta on a peer-to-peer network, please search for “peer-
to-peer” in the MicroEdge PowerME portal.
Configuration Options 3



Installation Options and Requirements1
Sample Client/Server Configuration

In the following example of a client/server configuration, the GIFTS Alta 
database resides on the database server and the GIFTS Alta program files are 
installed on file servers and remote workstations. Specifically, the GIFTS 
Alta components are installed as follows:

❖ Database Server: the GIFTS Alta database.

❖ File Servers: GIFTS Alta program files (EXEs), report templates, 
correspondence templates.

❖ Headquarters & Field Workstations: GIFTS Alta system files, ODBC 
drivers (used to connect to the database).
4 Configuration Options



Installation Options and Requirements 1

❖ Remote Workstations: GIFTS Alta program files (EXEs), report 

templates, ODBC drivers (used to connect to the database).

Note: The file server and database server may reside on the same computer.

As with the standalone and file server configurations, clients with a client/
server system can provide access to GIFTS Alta using Citrix Presentation 
Server.

Do I Need a Client/Server System?

Most GIFTS Alta clients who use the product at a single site find that the file 
server version meets all of their requirements. MicroEdge recommends that 
you use the client/server version if any of the following apply to your 
system:

❖ a local area network (LAN)

❖ more than 20 concurrent users
Configuration Options 5



Installation Options and Requirements1

❖ a large volume of data (more than 30,000 grants)

Note: Clients who use the client/server version of the product are responsible 
for purchasing the Oracle or Microsoft SQL Server software, the client/
server infrastructure, and support—including the services of a qualified 
Database Administrator.

MicroEdge makes no claims regarding improved performance. However, 
since the use of client/server technology transfers the task of processing 
queries from the workstation to the server, performance should be 
improved by eliminating the need to pass large amounts of data to the 
workstation for processing.

Logically, the larger the database, the larger the data sets used when running 
queries, so clients with large amounts of data should reap the most benefits. 
For the same reasons, this is the preferred approach for those who require 
remote database access.

Of the two available client/server options, the Microsoft SQL Server version 
is significantly easier to install, setup, and administer. Oracle server requires 
a higher degree of training and expertise. The primary reason that 
grantmakers choose Oracle is when it is their organization’s corporate 
standard and the staff resources are readily available. 

For more information about upgrading up to a client/server setup for 
GIFTS Alta, please refer to “System Trade-up and Migration” on page 170.

GIFTS Connections Configurations

For information about GIFTS Connections configurations that provide 
Internet access to GIFTS through MyGIFTS or ReviewerCONNECT, please 
refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation 
and Technical Reference Guide.
6 Configuration Options



Installation Options and Requirements 1

GIFTS Alta Storage Requirements

This section details the amount of hard disk space you will need for the 
various components of GIFTS Alta. Since there are many possible 
configurations of GIFTS Alta, the space needed for each GIFTS Alta 
component is provided separately. For information about system 
requirements for GIFTS Connections, please refer to the GIFTS Connections: 
MyGIFTS and ReviewerCONNECT Installation and Technical Reference Guide.

Once you have determined which files you will be installing, you can use the 
guidelines in “Calculating Your Storage Requirements” on page 10 to 
calculate the requirements for each computer in your configuration.

GIFTS Alta Directory Disk Space Requirements

This section details the contents of and the approximate amount of space 
needed for the GIFTS Alta directory. 

Note: The requirements indicated for your correspondence and reports 
templates are an estimate based on typical usage; if you have a large number 
of templates or use graphics in your templates, you may need more space for 
your templates.

❖ On a standalone workstation, the GIFTS Alta directory resides on the 
local hard drive and will contain the following files.

Program Files (EXEs) 121 MB

GCS Setup Files (including Job 
Manager files)
(clients with GIFTS Connections only)

41 MB

Other Setup Files (AltaLink, 
AltaReminder, Crystal Reports, MDAC, 
and .NET, among others)

243 MB

Miscellaneous(including PDF files) 50 MB

Report Templates 30 MB

Correspondence Templates 20 MB

Total ~500 MB
GIFTS Alta Storage Requirements 7
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❖ In network installations, the GIFTS Alta directory resides on the file 

server and includes all of the files installed for standalone systems, as well 
as the setup files used to install GIFTS Alta on your workstations and—
for clients with GIFTS Connections—the files used to install GCS.

In some cases, your system administrator may decide to locate the GIFTS 
Alta program files on each workstation’s hard drive instead of the file 
server to improve performance.

Note: The GIFTS Alta directory also contains the IGAM folder used to store 
data for the optional Internet Grant Application Manager. If you use IGAM, 
be sure to add the IGAM requirements described in “IGAM Disk Space 
Requirements” on page 9 to your GIFTS Alta directory total.

GIFTS Alta Database Disk Space Requirements

This section details the amount of space needed for the GIFTS Alta 
database:

❖ If you have a standalone or file server installation, GIFTS Alta uses an 
Access database which resides in your GIFTS Alta directory. The database 
will start out quite small, about 6.5 megabytes, but will grow as you enter 
data. Make sure to anticipate the potential size of your database when 
calculating how much disk space you’ll need. In general, you should 
allocate about 20 megabytes for each 1,000 grants in the database.

Program Files (EXEs) 121 MB

Miscellaneous (including PDF files) 50 MB

Report Templates 30 MB

Correspondence Templates 20 MB

Workstation Setup Files 105 MB

GCS Setup Files (including Job 
Manager files)
(clients with GIFTS Connections only)

41 MB

Other Setup Files (Crystal Reports, 
MDAC, and .NET, among others)

243 MB

Total ~650 MB
8 GIFTS Alta Storage Requirements
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❖ If you have a client/server installation, your database resides on the 

Microsoft SQL or Oracle server (not on your network server, unless they 
are the same). When you create the database, you assign an appropriate 
size to the database.

A good rule of thumb is to allocate about 20 megabytes for each 1,000 
grants in the database, with an additional 25% of the database size for the 
log file. You should consider historical data, current data, and reasonable 
growth over the next several years when you calculate the appropriate 
database size.

Workstation Disk Space Requirements

This section details the approximate amount of space needed for the system 
files, GIFTS Alta online help files, and Crystal Reports installed on each 
GIFTS Alta workstation. 

IGAM Disk Space Requirements

The IGAM directory located within your GIFTS Alta directory stores global 
settings, application forms, form image files, applications, and application 
attachments used with IGAM. If you use IGAM, you should include these 
disk space requirements in your calculation of the GIFTS Alta directory size.

The space required for IGAM depends on your use of it. As a general 
guideline, you should set aside about 10 MB of disk space for every 100 
applications retrieved. Of course, if your application forms are designed with 
a large number of data fields—especially additional contacts and/or long 
text answers—your application size may increase considerably.

Another storage issue to consider is whether you accept file attachments 
from your applicants. If you accept attachments, you can adjust the attached 
file size limit for each form to help manage your projected storage capacity.

System Files 100 MB

Help Files 20 MB

Crystal Viewer 130 MB

Total 250 MB
GIFTS Alta Storage Requirements 9
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Calculating Your Storage Requirements

Use the following guidelines to calculate the requirements for your 
standalone, file server, or client/server system. The figures used are derived 
from the breakdown of requirements provided in the preceding section, 
“GIFTS Alta Storage Requirements” on page 7.

If you intend to install a standalone GIFTS Alta system, add the figures for the 
GIFTS Alta directory, database, and workstation files. This is the amount of 
disk space required for you to install GIFTS Alta on a single computer. For 
example:

If you intend to install GIFTS Alta on a file server, add the figures for the GIFTS 
Alta directory and your GIFTS Alta database—the total is the amount of 
space required on your file server. Clients with IGAM should also include 
space needed to accommodate the growth of the IGAM directory. For 
example:

As detailed in “Workstation Disk Space Requirements” on page 9, each 
GIFTS Alta workstation requires 105 MB of disk space for the GIFTS Alta 
system files and online help files.

If you intend to install a client/server version of GIFTS Alta, the amount of space 
indicated for the GIFTS Alta directory—and the IGAM directory, if 

GIFTS Directory 500 MB

Database + 40 MB (for 2,000 records)

Workstation Files + 250 MB

Total Installation = 790 MB

GIFTS Directory
(with workstation and GCS setup files)

650 MB

IGAM Directory + 200 MB (for 2,000 applications)

Database + 100 MB (for 5,000 records)

Total File Server = 950 MB
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applicable—is required on your file server. The amount of disk space 
necessary on your database server should be established using the 
calculations specified for a client/server database.

Here is an example of the space requirements for a client/server system that 
includes IGAM; hardware and software requirements for GIFTS 
Connections are described in the GIFTS Connections: MyGIFTS and 
ReviewerCONNECT Installation and Technical Reference Guide.

GIFTS Database 400 MB (for 20,000 records)

GIFTS Database Log + 25 MB

GIFTS Database Server Total = 425 MB

GIFTS Directory
(with workstation and GCS setup files)

650 MB

IGAM Directory + 200 MB (for 2,000 applications)

GIFTS File Server Total = 850 MB

Each GIFTS Workstation = 250 MB
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Hardware Configuration Guidelines

The following sections detail the configuration guidelines for GIFTS Alta 
workstations, GIFTS Alta file servers, and the database server for a client/
server implementation of GIFTS Alta.

The compatibility information in this section is current as of October 2013.

Please refer to the most recent GIFTS Alta Compatibility Facts Sheet on the 
GIFTS PowerME site for comprehensive compatibility information. Search 
for ‘Compatibility Facts Sheet’ and select the latest document for your 
version of GIFTS Alta.

Important: MicroEdge provides configuration guidelines for planning 
purposes only. Because there is such a wide range of variables that affect the 
performance of your system, MicroEdge assumes no responsibility for 
hardware and software purchasing decisions. Please consult your systems 
consultant before making specific configuration decisions.

GIFTS Alta Workstations (Standalone or 
Networked)

The following are minimum system configuration guidelines for standalone 
GIFTS Alta workstations and to GIFTS Alta workstations in a network 
environment.

Processor (CPU) Intel® Core™2 Duo CPU (or equivalent) computer. For optimal 
performance, use the fastest available processor

Memory (RAM) 2GB of RAM

NOTE: If available on your computer(s), MicroEdge recommends 
using matched memory sticks to enable dual-channel or triple-
channel memory support. For more details, see http://
en.wikipedia.org/wiki/Multi-channel_memory_architecture.

Disk Capacity Please refer to “GIFTS Alta Storage Requirements” on page 7.

Operating 
Systems

❖ Windows 7 or 8 (32 or 64-bit)

❖ Windows XP Professional SP-3

Monitor 1280 x 720 resolution with small fonts
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GIFTS Alta File Servers

The following system configuration guidelines apply to the GIFTS Alta file 
server on a local area network. The file server is the computer on which the 
GIFTS Alta database, templates, reports, and other supporting files reside. 

Note: On client/server systems, the GIFTS Alta database is usually located on 
a separate database server.

Input Device Microsoft-compatible mouse.

New Installation 
and Upgrade/
Maintenance 
downloads

GIFTS Alta installation and upgrade/maintenence releases are 
always in the form of a compressed zip file download which must 
be extracted to a location on the workstation or server. Once 
extracted, it is usually required to run a setup.exe file to begin the 
upgrade process. In a networked environment, you do not need a 
copy of the files on every workstation; as long as the files are 
copied/extracted to a shared folder on the network you can update 
GIFTS Alta.

For upgrades, please refer to the Upgrade Installation Instructions 
emailed to you for specific details.

Processor (CPU) Contact your systems integrator to determine the appropriate 
processor needed to support GIFTS Alta and all other file server 
applications. For optimal performance, use the fastest available 
processor.

Disk Capacity Please refer to “GIFTS Alta Storage Requirements” on page 7.

Memory (RAM) Contact your systems integrator to determine the memory 
requirements for GIFTS Alta and all other file server applications. 
More memory may improve performance or be required as your 
grants database grows.

Operating Systems Windows 2003 Server R2

Windows 2008 Server R2 (64-bit)

Installation files Either on the server or on any network-connected workstation. 
Needed for installations and upgrades.
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GIFTS Alta Client/Server Database Server

For client/server systems only: the following system configuration 
guidelines apply to the Microsoft SQL or Oracle server on which the GIFTS 
Alta database resides.

IGAM Hardware Requirements

The GIFTS Alta installation program installs the latest version of IGAM for 
clients who have purchased it. IGAM is a Windows-based GIFTS module 
that requires an Internet connection to access applications that are stored on 
the MicroEdge IGAM server. The hardware requirements for managing 
your online application process through IGAM are:

Processor (CPU) Contact your systems integrator to determine the appropriate 
processor needed to support GIFTS Alta and all other client/server 
applications. For optimal performance, use the fastest available 
processor.

Note: Different versions of Microsoft SQL Server have limits in 
how they utilize processors and memory (Microsoft SQL Server 
Express, for example). Please consult your selected database 
technical documentation for best utilization of processors and 
memory.

Disk Capacity Please refer to “GIFTS Alta Storage Requirements” on page 7.

Memory (RAM) Contact your systems integrator to determine the memory 
requirements for GIFTS Alta and all other client/server 
applications. More memory may improve performance or be 
required as your grants database grows.

Note: Different versions of Microsoft SQL Server have limits in 
how they utilize processors and memory (Microsoft SQL Server 
Express, for example). Please consult your selected database 
technical documentation for best utilization of processors and 
memory.

Client/Server 
Database Software

Microsoft SQL Server 2008 (32 and 64-bit)

Microsoft SQL Server 2012 (64-bit)

Installation files Either on the server or on any network-connected workstation. 
Needed for installation, upgrades, and maintenance releases.
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GIFTS Alta-configured workstation Since IGAM is a GIFTS module, it must 
be run from a GIFTS Alta workstation. This allows IGAM to access the 
GIFTS Alta database and utilize your existing permissions and security 
settings.

Internet connection To activate an application form, its data must be 
uploaded to the MicroEdge IGAM server from your workstation through an 
active Internet connection. Completed applications are stored on the 
MicroEdge IGAM server and must be downloaded through your Internet 
connection. While any dial-up or broadband connection will work, keep in 
mind that a dial-up connection may be impractical if you expect to receive a 
large volume of applications and/or applications with attachments.

Ability to make outgoing connections through Port 80 and 443 Form and 
application data is transmitted to and from the MicroEdge server in XML 
format over HTTP. To upload form data and download application data, 
your firewall must allow outgoing HTTP traffic through Port 80, the 
industry standard configuration for web access. Port 443 is required for 
encrypted HTTPS (SSL) traffic during the publishing and retrieving of 
applications and requirements. If Port 443 is not available, please contact 
Technical Support.

Disk space Please refer to “IGAM Disk Space Requirements” on page 9 for 
information about the disk space requirements for IGAM.

Internet Access

MicroEdge clients with current Maintenance and Support contracts can 
access MicroEdge’s full range of technical support services over the Internet. 
From MicroEdge’s website (http://www.microedge.com), you can login to 
GIFTS PowerME to download the latest GIFTS Alta maintenance releases 
and access technical information in the MicroEdge PowerME portal.

In order to use these services, you need an Internet connection and browser.

GIFTS Alta Upgrades

An Internet connection is required for the download of all GIFTS Alta 
product upgrades which are in the form of a compressed zip file. The zip file 
is extracted to a folder on a workstation or server and a setup.exe file is run 
Hardware Configuration Guidelines 15



Installation Options and Requirements1

to begin the installation process. Clients scheduled for an upgrade will 
receive specific download and installation instructions via email.
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Performance Considerations

There are many factors that affect overall system performance. The factors 
that typically have the greatest impact on GIFTS Alta performance include, 
but are not limited to:

❖ Workstation and/or server processor speed and memory

❖ Microsoft® Windows® configuration and optimization

❖ The size of your database

❖ Network topology, cable type, capacity, and traffic

❖ The number of concurrent GIFTS Alta users

❖ The load that other applications place on your server or servers

For more information about optimizing the performance of a GIFTS Alta 
system, please search for “performance” in the GIFTS PowerME portal.
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Software Considerations

All software that interacts with GIFTS Alta must be certified for use with 
GIFTS Alta to ensure proper performance. 

Please refer to the most recent GIFTS Alta Compatibility Fact Sheet on the 
GIFTS PowerME site for comprehensive compatibility information. Search 
for ‘Compatibility Facts Sheet’ and select the latest document for your 
version of GIFTS Alta. 

Please review and consider the following information about access rights, 
word processor version control, Crystal Reports, software backups, system 
files, and Oracle table names.

Server Access Rights

GIFTS Alta requires that all users have full access rights to the GIFTS Alta 
directory and all of its subdirectories.

Word Processor Version Control

GIFTS Alta makes extensive use of Microsoft’s OLE technology to enable 
the automated production of correspondence using compatible versions of 
Microsoft Word. However, different versions of Word may handle 
embedded merge fields differently. 

Important: MicroEdge strongly recommends that you install the same 
version of Microsoft Word on all GIFTS Alta workstations and, if applicable, 
computers running the MyGIFTS Job Manager.

If you use GIFTS Alta at different sites on a network and you have different 
versions of Word at each site, each site must use separate correspondence 
templates that are specific to the version of Word used at that site.

Be aware that users with different versions of Word cannot share the letter and 
write-up templates used to create correspondence from GIFTS Alta. In addition, the 
use of more than one version of Word can significantly complicate the 
support and troubleshooting of your system. 
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When you upgrade Microsoft Word, you may have to update your GIFTS 
correspondence templates. There may be specific steps necessary to 
successfully “upgrade” your templates for continued compatibility with the 
GIFTS Alta mail merge functions. Whenever you plan to upgrade your 
word processing software, be sure to contact MicroEdge Technical Support 
for further information.

Microsoft Word 2010 Trusts

Microsoft introduced the Trust Center functionality in Office 2010. This 
requires special configuration on each workstation installed with Office 
2010 in order to properly use GIFTS Alta correspondence templates. 

Please follow the steps below: 

1 Open Microsoft Word 2010 and go to File > Options > Trust Center

2 Click the Trust Center Settings... button

3 Click Trusted Locations on the left panel

4 Check Allow Trusted Locations on my network option

5 Click Add new location...

6 Add the GIFTS folder as a new location (usually C:\GIFTS)

7 Check the box for Subfolders of this location are also trusted.

If the above does not resolve the issue, in the Trust Center window, click File 
Block Settings in the left panel. Some settings that dictate what files the 
Trust Center will block may need to be unchecked as well. 

Crystal Reports Version Control

GIFTS Alta uses an SAP Crystal Reports viewer to generate many of the 
standard reports provided. If you plan to install GIFTS Alta on any computer 
that also runs Crystal Reports, or vice versa, please refer to “Compatibility 
with Crystal Reports” on page 184.
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System Backups

MicroEdge strongly recommends that you take the following precautions to 
protect your grantmaking data:

❖ Back up your GIFTS Alta system daily using high-capacity archival media.

❖ Store backups in secure locations, both on-site and at a remote location.

❖ Use industry-standard products that enable reliable and verified file 
backups and quick restores. 

❖ Configure your backup software to back up open files. This ensures that 
the GIFTS Alta database is backed up even if users are logged in while the 
backup processes are running.

For detailed information about backing up GIFTS Alta, please search for 
“backups” in the MicroEdge PowerME portal. 

System Files

GIFTS Alta has been designed to work with the compatible word processor, 
spreadsheet, email, and accounting software of your choice. In order for 
these products—and all other software on your computers—to work 
together properly, they need to be carefully installed, optimized, and tested. 
In some cases, conflicts between applications may require troubleshooting 
and resolution by your internal technical support staff.

Problems may occur when an application installs an older version of a 
system file (such as a DLL or OCX file) over a newer version used by 
another application. MicroEdge provides a diagnostic utility that identifies 
the system files installed by GIFTS Alta and their current properties. For 
more information about this utility, please refer to “Maintenance, Security, 
and Data Integrity” on page 155.

Note: MicroEdge Technical Support staff can attempt to assist clients with 
Maintenance and Support contracts to identify and resolve GIFTS Alta-
related system file problems that affect more than one workstation. 
However, clients are responsible for resolving environmental issues. For 
more information about MicroEdge’s support policy, please refer to the 
MicroEdge Client Resource Guide.
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The “GIFTS Alta Impact Analysis” on page 176 lists the system files installed 
for GIFTS Alta. This valuable reference identifies the name, date, size, and 
location of each file, and can be used to identify potential conflicts or to 
troubleshoot system errors.

Oracle Database Tables and Names

The grants database on Oracle server versions of GIFTS Alta may reside on 
a database applications server with other Oracle databases. Compatibility 
among these databases must be carefully considered if you plan to use a 
single database server for both GIFTS Alta and other databases.

Important: Ensure that no other objects (tables, aliases, etc.) on the database 
server have both the same name and the same owner as that of any GIFTS 
Alta table. (Contact Tech Support for the default owner of the GIFTS Alta 
tables.) No conflicts occur if another table shares the same name or alias as a 
GIFTS Alta table, but the two tables must have different owners.

The GIFTS Alta database tables are:

Account_Transactions Acct_Info Activities

Activities_Ext Addresses Affiliations

Affiliations_ext Applications Bank_Accounts

Binary_Store Budget_Adjustments Budget_Auth_Users

Budget_Details Budget_Years Check_Details

Check_Requisitions Check_Templates Codes

Coding_Sheets Consolidation_Xref Contacts

Contacts_Ext Custom_Ext Dashboard_Parts

Delete_Log EG_Audit_Trails EG_Limit_Periods

EG_Limits EG_Programs EG_Rate_Periods

EG_Rates EntityProperty FormDefinition

FormPrompt FormSection FormUser

FormUserGroup GCS_Sessions GFW_Currencies
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GFW_Currencies_History GFW_Locks GFW_Preferences

GFW_View_Columns GFW_View_Sorts GFW_Views

GFW_Workspace GridField GridSort

Groups Header_Details IGAM_Forms

Jobs Keys Label

Letter_Events Letter_Lib Log

Match_Batches Matches Message_Board

Organizations Organizations_Ext Payments

Payments_Ext Permissions Postal_Codes

Report_Fields Report_Formats Report_Lines

Report_Sections Report_Sorts Reports

Reports_Library Requests Requests_Ext

Requirements_Ext Review_Rules Review_Stages

Reviews Reviews_Ext Reviews_InProgress

Rule_Reviewers Searches Select_Clauses

Tables Tables_Master Task_History

Tasks Temp_Data Text_File

UDF Users Wire_Transfers

Workflow WorkflowExecution WorkflowExecutionStep

WorkflowStep WorkflowUpdate XML_Store
22 Software Considerations



2 New GIFTS
Alta Standalone or

File Server
Installation

This chapter describes the process for a new installation of GIFTS 
Alta on a standalone workstation or a file server system with an 
Access database.
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Before You Begin

The following important points should be addressed before you install 
GIFTS Alta:

❖ Please read this entire chapter carefully. You should understand the entire 
installation process before you begin.

❖ If Crystal Reports is installed on any computer on which you plan to install 
GIFTS Alta, please see “Compatibility with Crystal Reports” on page 184.

❖ GIFTS Alta uses Microsoft Word to produce correspondence and write-
ups. Please make sure that a compatible version of Microsoft Word has 
been correctly installed and is currently functioning without errors.

❖ Install the latest proven service packs for Windows and your device drivers 
(such as video drivers and printer drivers).

❖ If you use virus-protection software, please make sure that it is disabled 
before attempting to run the installation. An active virus-protection 
program may cause errors during the installation process.

❖ Read the following sections, “About the Standalone Installation 
Process”and “About the File Server Installation Process”, to determine the 
type of installation that you need to perform.

The above points are vital towards insuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.

About the Standalone Installation Process

This type of installation is for clients who have purchased a single-user 
version of GIFTS Alta. It installs the entire GIFTS Alta system on the local 
hard drive of a single workstation, and only this workstation will have access 
to GIFTS Alta. To perform this type of installation, please follow the 
instructions in “New Standalone Installation” on page 26.
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About the File Server Installation Process

This installation installs GIFTS Alta on a network file server and one or 
more workstations. Please be aware that the number of concurrent users is 
limited by the number of user licenses you have purchased.

This installation includes two parts: a Server Installation process—which 
installs shared files, including the GIFTS Alta database, on the server—and a 
Workstation Installation, which installs files to each workstation and connects 
each workstation to the GIFTS Alta system on the server.

To perform this type of installation, please follow the instructions in “File 
Server Installation” on page 30.

System Files

For a complete list of the system files installed by the GIFTS Alta setup 
process, please refer to the “GIFTS Alta Impact Analysis” on page 176.

How to Obtain Technical Support

If you have any problems during your installation, please contact MicroEdge 
Technical Support.

❖ by submitting an electronic support request. Go to 
http://www.microedge.com and log in to the PowerME support website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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New Standalone Installation

This type of installation is for clients who have purchased a single-user 
version of GIFTS Alta. It installs the entire GIFTS Alta system on the local 
hard drive of a single workstation; only this workstation will have access to 
GIFTS Alta.

Step 1: Copying Your GIFTS Alta Configuration 
File

This procedure describes how to copy the configuration file for your GIFTS 
Alta system from your extracted GIFTS Alta installation Files. This file must 
be available during the installation process.

1 Copy the gifts.cfg file to a convenient location on your hard drive. Make 
a note of this location: you will need to know it when you install GIFTS 
Alta.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Step 2: Installing GIFTS Alta

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation.

1 Extract the MicroEdge GIFTS Alta Installation Files to your workstation.

2 Access the Master\Install folder of the GIFTS Alta installation files and run 
the Steup.exe file. The GIFTS Alta Welcome screen is displayed.

Note: Throughout the installation, you can click the Next button to 
continue, the Back button to return to the previous screen, or the Cancel 
button to cancel the installation.
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3 Click Next. The Select Setup Type window opens.

4 Select the “Local Installation (single user)” option and click Next. The 
Choose Destination Location window indicates that GIFTS Alta will be 
installed in C:\GIFTS, the recommended location.

Note: If you want to install GIFTS Alta to a different location on your 
workstation, click Browse and select the destination folder.

5 Click Next. The Configuration window prompts you to specify the 
location of your GIFTS Alta configuration file.

6 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS Alta.

7 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS Alta program icons to be displayed in the Windows 
Start menu.

8 Click Next. The Start Copying Files window displays a summary of the 
installation options you chose. The Current Settings field should indicate 
that a “Local GIFTS Alta Installation” is to take place in the folder you 
specified.

9 If the options are correct, click Next. The installation begins.

10 If your computer is not running a compatible version of the Microsoft Data 
Access Components (MDAC) software needed to run GIFTS Alta, you are 
prompted to install it. Click OK and follow the on-screen instructions to 
complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 9.

11 When the installation is complete, you are notified. Click Finish.

GIFTS Alta is now installed. Please proceed to the next section to complete 
your setup.
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Step 3: Configuring Windows for Use with GIFTS 
Alta

If you are going to use GIFTS Alta to create correspondence in Microsoft 
Word, please use the following procedure to set up Microsoft Windows so 
that GIFTS Alta and Word can share data properly:

1 Go to Windows Start ➤ Computer to open the Windows Explorer.

2 From the Explorer menu, go to Organize ➤ Folder and search options, 
View ➤ Folder Options, or View ➤ Options (the name of the menu item 
is different depending on your version of Windows).

3 Click the View tab.

4 Ensure that the “Hide extensions for known file types” or “Hide MS-DOS 
file extensions for types that are registered” check box is not selected. Use 
of this option can interfere with the way in which Microsoft Word merges 
data from GIFTS Alta.

Tip: After installing GIFTS Alta on any workstations running Windows 
Vista, 7, or 8, and before logging into GIFTS Alta, you should give the 
workstation user full permissions to the gifts.ini file in the C:\WINDOWS 
directory. If you do not do this and log into GIFTS, the updated gifts.ini file will 
instead be stored in the following location: C:\Users\[user 
name]\AppData\Local\VirtualStore\Windows. If you need to make any 
changes to the gifts.ini file, do so from this location. This applies to all 
workstations running Windows Vista, Windows 7, or Windows 8.

If you make modifications to the GIFTS.ini in the 
C:\Users\[username]\AppData\Local\VirtualStore\Windows folder, please be 
sure to copy the same file to the C:\Windows folder so they match.

Your single-user installation of GIFTS Alta should now be complete: enjoy!
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Logging in to GIFTS Alta for the First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS Alta workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS Alta 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
Alta for your organization, as described in the GIFTS Alta Administrator’s 
Guide.
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File Server Installation

This type of installation installs GIFTS Alta on a network file server and one 
or more workstations. Note that the number of users that can log in to 
GIFTS Alta at any given time cannot exceed the number of user licenses that 
you have purchased.

In a network environment, GIFTS Alta must be installed on the file server 
first:

❖ The Server Installation procedure installs the database, program files, and 
report template files to the network directory that you specify. This part 
of the installation is run only once using the MicroEdge GIFTS Alta 
Installation files, and can be run from any workstation.

Note: The server installation also performs a workstation installation on 
the computer from which you run it. Run the server installation from a 
computer that you plan to use as a GIFTS Alta workstation.

❖ Then, you can use the Workstation Installation procedure to install GIFTS 
Alta on all other workstations that are to have access to GIFTS Alta. This 
procedure installs the workstation files needed to run GIFTS Alta.

Prerequisites for File Server Installations

Before beginning the file server installation, make sure that you have met 
the following prerequisites.

❖ Please make sure you have access to an in-house network administrator, 
or a consultant familiar with your network environment, who has full 
network administrative access rights.

❖ The user installing the system must have the access rights needed to create 
a directory on the target drive where GIFTS Alta will be installed.

❖ All users of GIFTS Alta must have full access rights to the network 
directory where the GIFTS Alta system is to be installed.

❖ For clients using Novell network server, increase the Record Locking 
Threshold per Connection to 10,000. This will prevent the server from 
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exceeding the maximum “record locking threshold” during the use of the 
GIFTS Alta database. 

For more information on increasing this Novell setting, please consult 
with your network administrator.

Once you have verified that these prerequisites have been met, you may 
proceed to the next section, “Copying Your GIFTS Alta Configuration File”.

Copying Your GIFTS Alta Configuration File

This procedure describes how to copy the configuration file for your GIFTS 
Alta system from your extracted GIFTS Alta Installation Files. This file must 
be available during the installation process.

1 Copy the gifts.cfg file to a convenient location on your file server’s hard 
drive. Make a note of this location: you will need to know it when you 
install GIFTS Alta.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Installing GIFTS Alta on Your File Server

In a network environment, you must first install the GIFTS Alta database, 
program files, and template files on your file server. On any computer you 
plan to use as a GIFTS Alta workstation, use the following procedure to 
install these files:

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation.

1 Extract the MicroEdge GIFTS Alta Installation files to a workstation with 
network access. 
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2 Access the Master\Install folder and run the Setup.exe file. The GIFTS 

Alta Welcome screen is displayed.

Note: Throughout the installation, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.

3 Click Next. The Select Setup Type window opens.

4 Select the “Network Installation” option and click Next. The Choose 
Destination Location window opens.

5 Click Browse and specify the location of the GIFTS Alta directory. You 
should choose a network location that will be accessible to all the 
workstations that will run GIFTS Alta.

Example: You want to install GIFTS Alta on the P: drive of your network 
file server. Enter P:\GIFTS after clicking Browse. The GIFTS Alta 
database, program files, correspondence templates, and report templates 
will be copied to that folder (the “GIFTS directory”). If prompted that this 
folder does not exist, click Yes to create it.

6 After specifying the location of the GIFTS Alta directory, click Next. The 
Configuration Disk window prompts you to specify the location of your 
GIFTS Alta configuration file.

7 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS Alta.

8 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS Alta program icons to be displayed in the Windows 
Start menu.

9 Click Next. The Start Copying Files window displays a summary of the 
installation options you chose. The Current Settings field should indicate 
that a “GIFTS Alta Server Installation” is to take place in the folder you 
specified.

10 If the options are correct, click Next. The installation begins.

11 The install process may involve up to four steps depending what is 
currently installed on the workstation or server.
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❖ Install Alta program files

❖ Install Crystal Reports v11 files (if not currently installed)

❖ Install .Net 4 Framework (if not currently installed)

❖ Install MS Data Access Components (MDAC) (if not currently 
installed)

Note: If your computer is not running a compatible version of above 
software needed to run GIFTS Alta, you are prompted to install it. Click 
OK and follow the on-screen instructions to complete the installation 
from your downloaded files. After the installation, a message may inform 
you that your computer must be restarted to continue. Agree to the 
restart. After the computer has restarted, the setup program continues at 
step 12.

12 When the installation is complete, you are notified. Click Finish.

You are ready to proceed to the workstation installation procedure 
described in the next section.

Workstation Installation

After installing GIFTS Alta on your file server, you must install GIFTS Alta 
on each workstation that is to have access to GIFTS Alta. Use this procedure 
on each workstation to install the files needed to run GIFTS Alta.

Reminder: The workstation from which you ran the server installation is 
already set up as a GIFTS Alta workstation.

As part of the Server Installation, the workstation setup program was 
installed in the GIFTS Alta directory on your network; be sure to run your 
workstation installations from the network, not from the original workstation you 
extracted the master files to.

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.
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Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, then click 
Next. The Start Copying Files window opens.

4 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Alta Workstation 
Installation” is to take place in the folder you specified.

If the options are correct, click Next. The installation begins.

5 If the workstation is not running a compatible version of the Microsoft 
Data Access Components (MDAC) software needed to run GIFTS Alta, 
you are prompted to install it. Click OK and follow the on-screen 
instructions to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the installation is complete, you are notified. Click Finish.

GIFTS Alta is now installed on the workstation. If you are going to use 
GIFTS Alta to create merged correspondence in Microsoft Word, please use 
the following procedure to set up Microsoft Windows so that GIFTS Alta 
and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista, from the Explorer menu, choose Organize ➤ 
Folder and Search Options.

3 Go to the View tab (if applicable).
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4 Ensure that the “Hide file extensions for known file types” or “Hide MS-

DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS Alta.

Important: Be sure to repeat the entire Workstation Installation process on 
each workstation that should have access to GIFTS Alta. Ensure that all users 
have full access permissions for the GIFTS Alta directory and all of its 
subdirectories.

Your installation of GIFTS Alta should now be complete: enjoy!

Logging in to GIFTS Alta for the First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS Alta workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS Alta 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
Alta for your organization, as described in the GIFTS Administrator’s Guide.
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3New Microsoft SQL
Server Installation

This chapter describes how to install GIFTS Alta in the Microsoft 
SQL Server (2005 or later) environment.
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Before You Begin

Please address the following important points before you install GIFTS Alta:

❖ Please read this entire chapter carefully. You should understand the entire 
installation process before you begin.

❖ The installation process creates several network directories. Make sure 
that you have the necessary permissions to create these directories.

❖ GIFTS Alta uses Microsoft Word to produce correspondence and write-
ups. Please make sure that a compatible version of Microsoft Word has 
been correctly installed and is currently functioning without errors.

❖ If you use or intend to use Crystal Reports, make sure to read 
“Compatibility with Crystal Reports” on page 184.

❖ If you use virus-protection software, please make sure that it is disabled 
before attempting to run the installation. An active virus-protection 
program may cause errors during the installation process.

The above points are vital towards ensuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.

System Files

For a complete list of the system files installed by the GIFTS Alta setup 
process, consult the “Installation Impact Analysis” on page 175.

How to Obtain Technical Support

If you have any problems during your installation, please contact MicroEdge 
Technical Support.

❖ by submitting an electronic support request. Go to 
http://www.microedge.com and log in to the PowerME website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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Overview of the GIFTS Alta Installation 
Process

The procedures outlined below will take you through the entire process of 
installing the GIFTS Alta client/server edition for Microsoft SQL Server. 
The installation consists of the following major steps; each step corresponds 
to a section in this chapter.

Please follow these steps in the order in which they are presented. 
Addressing the steps in any other order will prevent your installation from 
being successful.

Step 1: Important Prerequisites In this step, you are asked to verify that you 
have the appropriate staff necessary for the installation process and that your 
SQL Server has been configured to accommodate the GIFTS Alta system. It 
also outlines prerequisites for your network environment.

Step 2: Setting Up the GIFTS ALTA Database This portion of the installation is 
used to create the GIFTS Alta database on the Microsoft SQL Server. This 
requires the services of a trained SQL Server Administrator who is familiar 
with all aspects of setting up and administering Microsoft SQL Server.

Step 3: Installing GIFTS ALTA on Your File Server In this step, you will install 
the GIFTS Alta program onto a network drive that is accessible to all 
workstations that will use GIFTS Alta. This procedure also configures the 
workstation you’re using as a GIFTS Alta workstation.

Step 4: Populating the GIFTS ALTA Database This step creates the table 
definitions for the GIFTS Alta database on the SQL Server, and populates 
that database with system-defined data necessary to the operation of GIFTS 
Alta.

Step 5: Installing the GIFTS Alta Workstations This step configures your 
other workstations to run GIFTS Alta. (The workstation on which you 
performed Step 3 is already configured to be a GIFTS Alta workstation.)

Step 6: Logging in to GIFTS Alta for the First Time This step describes how to 
log in to GIFTS Alta, verifying that your installation has been successful.
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Step 1: Important Prerequisites

The following prerequisites must be met before you begin your GIFTS Alta 
installation. Please note that MicroEdge Technical Support staff will only be 
able to assist you in troubleshooting your installation once all of these 
prerequisites have been met.

MicroEdge Technical Support staff can only assist you in matters related 
exclusively to the installation of GIFTS Alta software. For matters relating to 
your hardware, network, and the installation of Microsoft SQL Server, 
please consult with the appropriate vendors.

Prerequisites for the SQL Server Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to the services of a trained SQL Server 
Administrator familiar with all aspects of setting up and administering the 
SQL Server environment. MicroEdge Technical Support personnel 
cannot provide advice or assistance related to the setup of your SQL Server 
software and/or hardware.

✔ Ensure that your Microsoft SQL Server is properly installed and connected 
to your network, and that all desired client workstations can connect to it 
using the 2008 Management Studio.

✔ Ensure that all computers you plan to use with GIFTS Alta have adequate 
storage space and hardware, as described in “GIFTS Alta Storage 
Requirements” on page 7 and “Hardware Configuration Guidelines” on 
page 12.

✔ GIFTS Alta requires an ODBC driver on each workstation to connect to 
the SQL Server. These drivers are installed by the GIFTS Alta Setup 
program. 

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet 
on the GIFTS PowerME site for comprehensive compatibility 
information. Search for ‘Compatibility Facts Sheet’ and select the latest 
document for your version of GIFTS Alta.
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✔ To check the version of the ODBC driver installed on a workstation, you 

can use the “Data Sources (ODBC)” Control Panel.

✔ The maximum number of concurrent user connections allowed by the 
database server should be at least five times the number of GIFTS Alta, 
MyGIFTS, and ReviewerCONNECT users. To adjust this setting:

❖ In the 2008 Management Studio, right-click on the server and select 
Properties. Then, go to the Connections page.

✔ Configure your SQL Server to allow SQL Server authentication:

❖ In the 2008 Management Studio, right-click on the server and select 
Properties. Then, go to the Security page and select the “SQL Server 
and Windows Authentication mode” option.

Prerequisites for Your Network Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to an in-house network administrator, or a 
consultant familiar with your network environment, who has full network 
administrative access rights.

✔ The user installing the system must have the permissions needed to create 
a directory on the target drive where the GIFTS Alta file server will be 
installed.
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Other Installation Considerations

Please consider the following while installing GIFTS Alta:

✔ We recommend that you create your GIFTS Alta database with the 
following Collation Name: SQL_Latin1_GENERAL_CP1_CI_AS.

Be sure to specify this collation at both the database and table/field levels; 
queries may run slowly if there is a mismatch among the collation methods 
specified in your database. Also, if you are using SQL to migrate GIFTS 
Alta data from one server to another, you should make sure that the new 
GIFTS Alta database on the destination SQL server has the same collation 
settings as the GIFTS Alta database from the source SQL server. 

If you choose a different Collation Name, you must use one that includes 
a character set that is a superset of the recommended Collation Name’s 
character set. If you use a character set that does not include all the 
characters the GIFTS Alta database is programmed to use, your GIFTS 
Alta system may not work properly. A different Collation Name may also 
include a different sort order.

Important: The Collation Name recommended above is the only one with 
which GIFTS Alta has been tested and certified with SQL Server 2008, 
and SQL Server 2012. We will support GIFTS Alta when used with other 
Collation Names. However, be aware that if your choice creates issues in 
the GIFTS Alta system, the only solution our support staff may be able to 
offer is to change to the recommended setting.

✔ To run GIFTS Alta, all users must have full access rights to the GIFTS Alta 
directory that you install on your file server. Be sure to grant these rights 
as you set up your GIFTS Alta workstations.

Once you have verified that these prerequisites have been met, you may 
proceed to “Step 2: Setting Up the GIFTS ALTA Database”.
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Step 2: Setting Up the GIFTS Alta Database

This step creates a new SQL Server database and database login for GIFTS 
Alta, and should be performed by a trained SQL Server Administrator 
familiar with all aspects of setting up and administering the SQL Server 
environment.

During the creation of your database, you define the initial size of your 
database and database log. In general, you should allocate about 20 MB for 
each 1,000 grants in the database, with an additional 25% of the database 
size for the log file. Take your historical data, current data, and projected 
growth over the next several years into consideration when you calculate 
the database size.

Example: If your organization processes 1,000 grant requests per year, and you 
have five years of historical data, you should allocate approximately 200 MB 
for your database device (100 MB for your historical data and 100 MB for the 
next five years). 

During times of peak data entry, the database log can grow quite large and 
will eventually reach its size limit (if you establish a limit). The log should be 
monitored closely, backed up, and dumped on a regular basis, according to 
your SQL Server documentation. 

Managing Database Recovery and the 
Transaction Log

GIFTS Alta performs a dump of the transaction log prior to performing 
batch processes. 

Note: If you are using SQL 2008 (or later) or want point of failure recovery, 
you must do the following:

❖ Manually uncheck the Dump Transactions Log option in the 
Administrator Module's Preferences>General settings.  

❖ You will need to shrink the Transaction Logs manually on a regular 
basis if on Simple recovery mode. If using Full recovery mode, you 
will need to set the recovery mode to Simple, shrink the file, and then 
set the recovery mode back to Full.
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Configuring the transaction log dump is part of managing your database 
recovery. The database recovery preference you choose determines how the 
transaction log is managed. The selection and management of this 
preference is entirely the responsibility of the client.

MicroEdge recommends choosing 'Simple' or 'Full' as your database 
recovery preference ('Full' is the SQL default). 

❖ If you want your SQL server to automatically manage your transaction 
log, we recommend setting this preference to 'Simple.'

❖ If you want to manually manage your transaction log, choose 'Full.' 

For more information about manually managing your transaction log, 
please consult your Microsoft SQL Server documentation.

To set your database recovery preference:

1 From your GIFTS Alta database icon, right-click and select Properties.

2 Click the Options tab.

3 In the Recovery Model field drop-down menu, select ‘Simple’ or ‘Full.’

4 Click OK. 
44 Step 2: Setting Up the GIFTS ALTA Database



New Microsoft SQL Server Installation 3

If you are using SQL 2008 or later, you must indicate to GIFTS Alta that you 
want to turn off transaction log dumping. If you are using an earlier version 
of SQL and want point of failure recovery, you must also do this.

To turn off transaction log dumping:

1 From the Preferences Editor in the Administrator module, double-click 
Preferences in the System section.

2 At the bottom of the Preferences field, enter ‘DumpTransactions=0.’

3 Click OK.

Creating the GIFTS Alta Database and Login
for SQL Server 2008 or Later

The following procedures create the GIFTS Alta database and database login 
for SQL Server 2008 or later systems.

Step 2a: Creating the GIFTS Alta Login This step creates the Login ID used 
by the GIFTS Alta system to connect to the GIFTS Alta database. (Please 
contact Tech Support for the Login ID and password to use.)

Note: If you want to change the password, you may do so after you install 
GIFTS Alta. Note that when you change the password on the server, you 
must also update the database login information in the GIFTS.SYS or gifts.ini 
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file. For details on updating the Client/Server login ID and password in 
GIFTS Alta, please refer to the GIFTS Alta Administrator's Guide.

To create the Login ID:

1 Log in to the SQL Server Management Studio.

2 On the left panel of the Management Studio, click the plus sign to expand 
the server for which you wish to create the GIFTS Alta login.

3 In the list that appears, click the plus sign to expand the Security folder.

4 Right-click the Logins folder and select New Login from the menu. The 
New Login window opens.

5 Enter the login ID in the Login name field of the General page.

6 Select the SQL Server Authentication option.

7 De-select the “Enforce password policy” option, and verify that the 
“Enforce password expiration” and “User must change password at next 
login” options are also turned off. 

8 Enter the password.

Important: Passwords are case-sensitive for SQL Server 2008 or later.

9 Click OK to save the login.

Please continue to Step 2b to create the GIFTS Alta database.

Step 2b: Create the GIFTS Alta Database and Transaction Log This step 
creates the database named GIFTS Alta and its transaction log.

1 Log in to the SQL Server Management Studio.

2 On the left panel of the Management Studio, click the plus sign to expand 
the server on which you wish to create the GIFTS Alta database.

3 Right-click the Databases folder, and select New Database from the menu. 

4 In the Database name field, enter your database name of GIFTS Alta. 

5 In the Owner field, enter the ownername (the login that you created in 

Step 2a).
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6 In the database files table, specify the initial size of the database and its 

transaction log, and enter the expansion settings.

7 Go to the Options page.

8 In the Collation list, select SQL_Latin1_GENERAL_CP1_CI_AS.

Important: Before continuing, record the specifics of the GIFTS Alta 
database and store this information in a safe place. You may need this 
information to recreate the system in case of a server failure.

9 Click OK. The database is created.

Please continue to the next section to install GIFTS Alta on your network 
file server.
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Step 3: Installing GIFTS Alta on Your File 
Server

In a network environment, program files and report template files for 
GIFTS Alta must be installed on the file server first. This part of the 
installation is called the Server Installation, and is only run once.

Important: The workstation at which you perform the server installation is set 
up as a GIFTS Alta workstation during the installation process. Perform this 
procedure from a workstation that you intend to use with GIFTS Alta.

After installing the GIFTS Alta software on your server, you need to create 
an ODBC data source for the workstation and to configure Windows to 
allow correspondence templates to work. Instructions for these two tasks 
follow the network server installation instructions.

Step 3a: Copying the GIFTS Alta Configuration 
File

This procedure describes how to copy the configuration file for your GIFTS 
Alta system from your extracted GIFTS Alta Installation Files. This file must 
be available during the installation process.

1 Copy the gifts.cfg file to a convenient location on your hard drive. Make 
a note of this location: you will need to know it when you install GIFTS 
Alta.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Please proceed to the next step to install the GIFTS Alta server software.
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Step 3b: Installing GIFTS Alta on the File Server

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation before you proceed.

1 Extract the MicroEdge GIFTS Alta Installation files to a workstation with 
network access. 

2 Access the Master\Install folder and run the Setup.exe file. The GIFTS 
Alta Welcome screen is displayed.

Note: Throughout the installation, you can click the Next button to 
continue, the Back button to return to the previous screen, or the Cancel 
button to cancel the installation.

3 Click Next. The Select Setup Type window opens.

4 Select the “Network Installation” option and click Next. The Choose 
Destination Location window opens.

5 Click Browse and specify the location of the GIFTS Alta directory. You 
should choose a network location that will be accessible to all the 
workstations that will run GIFTS Alta.

Example: You want to install GIFTS Alta on the P: drive of your network 
file server. Enter P:\GIFTS after clicking Browse. The GIFTS Alta 
database, program files, and correspondence and report template files will 
be copied to that folder (the “GIFTS directory”). If prompted that folder 
does not exist, click Yes to create it.

6 After specifying the location of the GIFTS Alta directory, click Next. The 
Configuration Disk window prompts you to specify the location of your 
GIFTS Alta configuration file.

7 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS Alta.

8 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS Alta program icons to be displayed in the Windows 
Start menu.
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9 Click Next. The Start Copying Files window displays a summary of the 

installation options you chose. The Current Settings field should indicate 
that a “GIFTS Alta Server Installation” is to take place in the folder you 
specified.

10 If the options are correct, click Next. The installation begins.

The install process may involve up to four steps depending what is 
currently installed on the workstation or server.

❖ Install Alta program files

❖ Install Crystal Reports v11 files (if not currently installed)

❖ Install .Net 4 Framework (if not currently installed)

❖ Install MS Data Access Components (MDAC) (if not currently 
installed)

If your computer is not running a compatible version of above software 
needed to run GIFTS Alta, you are prompted to install it. Click OK and 
follow the on-screen instructions to complete the installation from your 
downloaded files.

Note: After the installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 9.

11 When the installation is complete, you are notified. Click Finish.

Step 3c: ODBC Data Source Creation

Please perform the following steps to create the ODBC Data Source the 
workstation needs to communicate with the GIFTS Alta database.

Important: Step 3b must be performed at the same workstation from which 
you ran step 3a above.

During the Server Installation, the MDAC installation program installed the 
ODBC driver that GIFTS Alta uses to connect to your Microsoft SQL Server. 
In this procedure, you will create an ODBC Data Source named GIFTS, 
50 Step 3: Installing GIFTS ALTA on Your File Server



New Microsoft SQL Server Installation 3

which GIFTS Alta uses to connect to the GIFTS Alta database. Please note 
that the user interface of the ODBC Administrator may vary.

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

3 From the list of drivers, choose SQL Server and click Finish. The ODBC 
SQL Server Setup window is displayed.

4 In the Name field, enter GIFTS.

5 Using the Server list, identify your SQL server. Click Next.

6 If there are options for specifying how SQL Server should verify the 
authenticity of the database login, choose SQL Server authentication to 
verify using a login ID and password entered by the user.

7 Enter the server’s login ID and password and click Next. 

8 If your version of the ODBC Administrator includes an option to “Use 
regional settings when outputting currency, numbers, dates, and times,” 
ensure that this setting is turned off. Note that your version of the ODBC 
Administrator may not have this option. Otherwise, use default settings.

9 Click Finish to close the ODBC Administrator. You now have an ODBC 
Data Source.

Step 3d: Microsoft Windows Configuration

If you are going to use GIFTS Alta to create merged correspondence in 
Microsoft Word, please use the following procedure to set up Microsoft 
Windows so that GIFTS Alta and Word can share data properly:

1 Go to Windows Start ➤ Computer to open the Windows Explorer.
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2 From the Explorer menu, go to Organize ➤ Folder and search options, 

View ➤ Folder Options, or View ➤ Options (the name of the menu item 
is different depending on your version of Windows).

3 Click the View tab.

4 Ensure that the “Hide extensions for known file types” or “Hide MS-DOS 
file extensions for types that are registered” check box is not selected. Use 
of this option can interfere with the way in which Microsoft Word merges 
data from GIFTS Alta.

Tip: After installing GIFTS Alta on any workstations running Windows 
Vista, and before logging into GIFTS Alta, you should give the workstation 
user full permissions to the gifts.ini file in the C:\WINDOWS directory. If 
you do not do this and log into GIFTS, the updated gifts.ini file is stored in 
the following location: C:\Users\[user name]\AppData\Local\VirtualStore 
\Windows. If you need to make any changes to the gifts.ini file, do so from 
this location. This is only necessary for workstations running Windows 
Vista. 

If you make modifications to the GIFTS.ini in the 
C:\Users\[username]\AppData\Local\VirtualStore\Windows folder, please be 
sure to copy the same file to the C:\Windows folder so they match.

When you are finished with all three steps of the workstation installation, 
you can proceed to “Step 4: Populating the GIFTS ALTA Database” below.
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Step 4: Populating the GIFTS Alta 
Database

This process creates the SQL Server tables and system-defined data for a 
new GIFTS Alta system. It must be run from the same workstation that you 
used in Steps 3a and 3b.

To populate the database:

1 Access the GIFTS folder and run the SQLInst.exe file. The Create SQL 
Database window opens.

2 Select the Create Source Database on Target Server option, then select 
the Copy Source Data to Target Server option.

The Source should be displayed as the location of the GIFTS.MDB file 
installed on the network server by Step 3a. 

Example: P:\GIFTS\GIFTS.MDB

This is a Microsoft Access version of the database; this process copies the 
database definitions to the GIFTS Alta database on your SQL Server.

3 In the Target area, confirm that Database reads GIFTS and that the Data 
Source shows the network path to the database file. The Target area also 
displays the Login ID and Password for the GIFTS Alta database.

4 Click OK to begin. A process monitor displays progress information. Save 
the process report for future reference; you may need it later.

The installation of your database is complete, and you are ready to set up 
your remaining workstations to use GIFTS Alta.
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Step 5: Installing the GIFTS Alta 
Workstations

This step consists of running the GIFTS Alta Workstation Installations and 
setting up the appropriate ODBC data source on each workstation. 

Important: The GIFTS Alta Workstation Installation must be run on every 
remaining workstation that is to have access to GIFTS Alta.

Remember that the workstation used in “Step 3: Installing GIFTS ALTA on 
Your File Server” is already set up as a GIFTS Alta workstation. To install 
GIFTS Alta on your other workstations, you must complete the following 
procedures at each workstation:

❖ Run the GIFTS Alta Workstation Installation.

❖ Set up the ODBC data source on the workstation.

❖ Ensure that Microsoft Windows is configured to work with the GIFTS 
Alta Correspondence option.

Step 5a: Installing GIFTS Alta

This process uses the GIFTS Alta Setup program to install the files needed 
to run GIFTS Alta from the workstation. The Server Installation installed 
the Setup program on the network; be sure to run your workstation installations 
from the network, not from the Master folder on the original workstation.

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, then click 
Next. The Start Copying Files window opens.
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4 Read the summary provided of the installation options you chose. The 

Current Settings field should indicate that a “GIFTS Alta Workstation 
Installation” is to take place in the folder you specified.

If the options are correct, click Next. The installation begins.

5 If the workstation is not running a compatible version of the Microsoft 
Data Access Components (MDAC) software needed to run GIFTS Alta, 
you are prompted to install it. Click OK and follow the on-screen 
instructions to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the installation is complete, you are notified. Click Finish.

Step 5b: ODBC Data Source Creation

During the Step 5a, the MDAC installation program installed the ODBC 
driver that GIFTS Alta uses to connect to your Microsoft SQL Server. In this 
procedure, you will create an ODBC Data Source named GIFTS Alta. This 
data source is used by GIFTS Alta to connect to the GIFTS Alta database. 
Please note that the user interface of the ODBC Administrator may vary.

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

3 From the list of drivers, choose SQL Server and click Finish. The ODBC 
SQL Server Setup window is displayed.

4 In the Name field, enter GIFTS.

5 Using the Server list, identify your SQL server. Click Next.

6 If there are options for specifying how SQL Server should verify the 
authenticity of the database login, select the option to verify using a login 
ID and password entered by the user.
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7 Enter the server’s login ID and password that you created in Step 2.

Click Next.

8 If your version of the ODBC Administrator includes an option to “Use 
regional settings when outputting currency, numbers, dates, and times,” 
ensure that this setting is turned off. Note that your version of the ODBC 
Administrator may not have this option. Otherwise, use the default 
settings.

9 Click Finish to close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.

Step 5c: Microsoft Windows Configuration

If you are going to use GIFTS Alta to create merged correspondence in 
Microsoft Word, please use the following procedure to set up Microsoft 
Windows so that GIFTS Alta and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista, from the Explorer menu, choose Organize ➤ 
Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS Alta.
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Step 5d: Microsoft Word 2010 Trusts

Microsoft introduced the Trust Center functionality in Office 2010. This 
requires special configuration on each workstation installed with Office 
2010 in order to properly use GIFTS Alta correspondence templates. 

Please follow the steps below: 

1 Open Microsoft Word 2010 and go to File > Options > Trust Center

2 Click the Trust Center Settings... button

3 Click Trusted Locations on the left panel

4 Check Allow Trusted Locations on my network option

5 Click Add new location...

6 Add the GIFTS folder as a new location (usually C:\GIFTS)

7 Check the box for Subfolders of this location are also trusted.

If the above does not resolve the issue, in the Trust Center window, click File 
Block Settings in the left panel. Some settings that dictate what files the 
Trust Center will block may need to be unchecked as well. 

When you have installed GIFTS Alta, created an ODBC Data Source, and 
configured Windows and Word properly on each workstation, your GIFTS 
Alta installation should be complete. Remember that to use GIFTS Alta, 
users must have full access rights to the GIFTS Alta directory on your file 
server.

Step 6: Logging in to GIFTS Alta for the First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS Alta workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS Alta 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
Alta for your organization, as described in the GIFTS Alta Administrator’s 
Guide.
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4 New Oracle
Server Installation

This chapter describes how to install GIFTS Alta in an Oracle server 
environment.
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Before You Begin

The following important points should be addressed before you install 
GIFTS Alta:

❖ Please read this entire chapter carefully. You should understand the entire 
installation process before you begin.

❖ If Crystal Reports is installed on any computer on which you plan to install 
GIFTS Alta, please see “Compatibility with Crystal Reports” on page 184.

❖ The installation process creates several network directories. Make sure 
that you have the necessary permissions to create these directories.

❖ GIFTS Alta uses Microsoft Word to produce correspondence and write-
ups. Please make sure that a compatible version of Microsoft Word has 
been correctly installed and is currently functioning without errors.

❖ If you use virus-protection software, please make sure that it is disabled 
before attempting to run the installation. An active virus-protection 
program may cause errors during the installation process.

The above points are vital towards insuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.

System Files

For a complete list of the system files installed by the GIFTS Alta setup 
process, consult the “Installation Impact Analysis” on page 175.
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How to Obtain Technical Support

If you have any problems during your installation, please contact MicroEdge 
Technical Support.

❖ by submitting a New Case request through PowerME. Go to 
http://www.microedge.com and log in to the PowerME website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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Overview of the Installation Process

The procedures outlined below will take you through the entire process of 
installing the GIFTS Alta client/server edition for Oracle server. The 
installation consists of the following major steps; each step corresponds to a 
section in this chapter.

Step 1: Important Prerequisites In this step, you are asked to verify that you 
have the appropriate staff necessary for the installation process, and that 
your Oracle server has been configured correctly to accommodate the 
GIFTS Alta system. It also outlines prerequisites for your network 
environment.

Step 2: Setting Up the GIFTS Database This portion of the installation is 
used to create the GIFTS Alta database on the Oracle server. This requires 
the services of a trained Oracle Database Administrator who is familiar with 
all aspects of setting up and administering the Oracle server environment.

Step 3: Installing GIFTS ALTA on Your File Server In this step, you will install 
GIFTS Alta onto a network drive that is accessible to all workstations that 
will use GIFTS Alta. This step also includes the configuration of a single 
workstation, which is necessary for Step 4.

Step 4: Populating the GIFTS ALTA Database This step creates the table 
definitions for the GIFTS Alta database on the Oracle server, and populates 
that database with system-defined data necessary to the operation of the 
GIFTS Alta system.

Step 5: Installing the GIFTS Alta Workstations This step configures your 
other workstations to run GIFTS Alta. (The workstation on which you 
performed Step 3 is already configured to be a GIFTS Alta workstation.)

Step 6: Logging in to GIFTS ALTA for the First Time This step describes how 
to log in to GIFTS Alta, verifying that your installation has been successful.
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Step 1: Important Prerequisites

The following prerequisites must be met before you begin your GIFTS Alta 
installation. Please note that MicroEdge Technical Support staff will only be 
able to assist you in troubleshooting your installation once all of these 
prerequisites have been met.

MicroEdge Technical Support staff can only assist you in matters related 
exclusively to the installation of GIFTS Alta software. For matters relating to 
your hardware, network, and the installation of the Oracle server, please 
consult with the appropriate vendors.

Prerequisites for the Oracle Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to the services of a trained Oracle Database 
Administrator familiar with all aspects of setting up and administering the 
Oracle environment. Please note that MicroEdge Technical Support 
personnel cannot provide advice or assistance related to the setup of your 
Oracle software and/or hardware.

✔ Ensure that Oracle server is properly installed, and ensure that all client 
workstations can connect to it using SQL Plus.

✔ GIFTS Alta requires ODBC drivers on each workstation to connect to the 
Oracle server. These drivers are installed by the GIFTS Alta Setup 
program. 

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet 
on the GIFTS PowerME site for comprehensive compatibility 
information. Search for ‘Compatibility Facts Sheet’ and select the latest 
document for your version of GIFTS Alta.

To check the version of the ODBC drivers installed on a workstation, you 
can use the “Data Sources (ODBC)” Control Panel.
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Prerequisites for Your Network Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to an in-house network administrator, or a 
consultant familiar with your network environment, who has full network 
administrative access rights.

✔ The user installing the system must have the permissions needed to create 
a directory on the target drive where the GIFTS Alta file server will be 
installed.

✔ Ensure that all computers you plan to use with GIFTS Alta have adequate 
storage space and hardware, as described in “GIFTS Alta Storage 
Requirements” on page 7 and “Hardware Configuration Guidelines” on 
page 12.

Once you have verified that these prerequisites have been met, you may 
proceed to “Step 2: Setting Up the GIFTS Database” below. 
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Step 2: Setting Up the GIFTS Database

This step of the installation involves creating a new database on the Oracle 
server for GIFTS Alta. This process requires the services of a trained Oracle 
Database Administrator familiar with all aspects of setting up and 
administering the Oracle environment.

Step 2a: Create the Database

The GIFTS Alta database must be defined with an appropriate size to 
accommodate the growth of the system by normal data entry, as well as any 
data that may be imported into your system from another source. In 
general, you should allocate about 20 MB for each 1,000 grant requests in 
your database.

Example: If your organization processes 1,000 grant requests per year, and you 
have five years of historical data, you should allocate approximately 200 MB 
for your database device (100 MB for your historical data and 100 MB for the 
next five years).

In order to run GIFTS, we recommend that you create your GIFTS Alta 
database with the following Character Set option:

❖ Character Set option = WE8ISO8859P1

❖ Sort Order option = binary

If you choose a different character set, make sure to choose one that is a 
superset of the recommended set. (If you use a character set that does not 
include all characters the GIFTS Alta database is programmed to use, your 
GIFTS Alta system may not work properly.) You can also use a different sort 
order.

Important: The character set and sort order recommended above are the only 
ones with which GIFTS Alta has been tested and certified. We will support 
GIFTS Alta when used with other character sets and sort orders. However, 
be aware that if your choices create issues in your GIFTS Alta system, the 
only solution our support staff may be able to offer is to change to the 
recommended settings.
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Note: The following steps are for Oracle Server 10g. The process in other 
versions may differ.

To create your GIFTS Alta database:

1 Launch the Database Configuration Assistant. The Welcome screen 
opens.

2 Click Next. On the next page, select Create a Database and click Next.

3 Select General Purpose and click Next.

4 In the Global Database Name field, enter GIFTS. The SID field is 
automatically populated with GIFTS. Click Next.

5 On the Management Options page, click Next.

6 Enter the password for the default user accounts in both the Password and 
Confirm Password fields, then click Next.

7 Specify the desired Storage Options, then click Next.

8 Specify the desired Database File Locations, then click Next.

9 Specify the desired Recovery Configuration, then click Next, and then 
Next again.

10 Specify the desired Initialization Parameters (as discussed above), then 
click Next.

11 Specify the desired Database Storage parameters, then click Next.

12 Click Finish, then OK. The GIFTS database is created.

Step 2b: Create the GIFTS Alta Login

A login user must be created for GIFTS Alta in order for GIFTS Alta to 
successfully connect to the database. Initially, you must use the default 
login ID and the password given to you by Microedge.

Note: If you want to change the password, you may do so after you install 
GIFTS Alta. Note that when you change the password on the server, you 
must also update the database login information in the GIFTS.SYS or gifts.ini 
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file. For details on updating the Client/Server login ID and password in 
GIFTS Alta, please refer to the GIFTS Administrator's Guide.

The name and location of this utility will vary for other versions of Oracle. 
Note that the instructions below are for Oracle 10g.

To create the GIFTS Alta login:

1 Log in to the Oracle Enterprise Manager Console.

2 Click I agree.

3 From the Administration tab, click Users in the Users & Privileges section. 

4 Click Create.

5 In the General tab, enter your chosen login ID in the 
Name field, and the password in the Enter Password and Confirm 
Password fields.

6 In the same window, move to the Roles tab, click Edit List, and select DBA.

7 Click > to move DBA to the Selected Roles column, then click OK. 

8 Select the Connect and DBA Admin Options, then click OK.

9 Specify any other desired login parameters, and click OK. The login is 
created.
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Step 3: Installing GIFTS Alta on Your File 
Server

In a network environment, the GIFTS Alta program files and templates 
must be installed on the file server first. This part of the installation is called 
the Server Installation, and is only run once.

Important: The workstation at which you perform the server installation is set 
up as a GIFTS Alta workstation during the installation process. Perform this 
procedure from a workstation that you intend to use with GIFTS Alta.

After you install the GIFTS Alta software on your file server, three more 
steps must be performed to complete network installation and the 
configuration of this GIFTS Alta workstation: Oracle service creation, 
ODBC data source creation, and configuring Microsoft Windows. 
Instructions for these three tasks follow the network server installation 
instructions below.

Step 3a: Copying the GIFTS Alta Configuration 
File

This procedure describes how to copy the configuration file for your GIFTS 
Alta system from your extracted GIFTS Alta Installation Files. This file must 
be available during the installation process.

1 Copy the gifts.cfg file to a convenient location on your hard drive. Make 
a note of this location: you will need to know it when you install GIFTS 
Alta.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Please proceed to the next step to install the GIFTS Alta server software.
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Step 3b: Installing GIFTS Alta on the File Server

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation before you proceed.

1 Extract the MicroEdge GIFTS Alta Installation files to a workstation with 
network access. 

2 Access the Master\Install folder and run the Setup.exe file. The GIFTS 
Alta Welcome screen is displayed.

Throughout the installation, you can click the Next button to continue, 
the Back button to return to the previous screen, or the Cancel button to 
cancel the installation.

3 Click Next. The Select Setup Type window opens.

4 Select the “Network Installation” option and click Next. The Choose 
Destination Location window opens.

5 Click Browse and specify the location of the GIFTS Alta directory. You 
should choose a network location that will be accessible to all the 
workstations that will run GIFTS Alta.

Example: You want to install GIFTS Alta on the P: drive of your network 
file server. Enter P:\GIFTS after clicking Browse. The GIFTS Alta 
database, program files, and correspondence and report template files will 
be copied to that folder (the “GIFTS directory”). If prompted that folder 
does not exist, click Yes to create it.

6 After specifying the location of the GIFTS Alta directory, click Next. The 
Configuration Disk window prompts you to specify the location of your 
GIFTS Alta configuration file.

7 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS Alta.

8 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS Alta program icons to be displayed in the Windows 
Start menu.
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9 Click Next. The Start Copying Files window displays a summary of the 

installation options you chose. The Current Settings field should indicate 
that a “GIFTS Alta Server Installation” is to take place in the folder you 
specified.

10 If the options are correct, click Next. The installation begins.

The install process may involve up to four steps depending what is 
currently installed on the workstation or server.

❖ Install Alta program files

❖ Install Crystal Reports v11 files (if not currently installed)

❖ Install .Net 4 Framework (if not currently installed)

❖ Install MS Data Access Components (MDAC) (if not currently 
installed)

If your computer is not running a compatible version of above software 
needed to run GIFTS Alta, you are prompted to install it. Click OK and 
follow the on-screen instructions to complete the installation from your 
downloaded files.

Note: After the installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 10.

11 When the installation is complete, you are notified. Click Finish.

Step 3c: Oracle Service Creation

To establish Oracle Service for this GIFTS Alta workstation:

1 Open the Oracle Net Configuration Assistant.

2 In the Welcome screen, select the “Local Net Service Name 
configuration” option and click Next. The Net Service Name 
Configuration window opens.

3 Select the “Add” option and click Next. The Net Service Name 
Configuration, Database Version window opens.
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4 In the Service Name field, enter the desired name (usually the database 

name). Click Next. The Net Service Name Configuration, Select Protocols 
window opens.

5 From the list, select the protocol for your network (contact your network 
administrator if you are unsure). Click Next. The Net Service Name 
Configuration, [Selected Protocol] window opens.

6 Enter the Host name and select the port number (use either the standard 
port number, or enter another one). Click Next. The Net Service Name 
Configuration, Test window opens.

7 Here, you may choose to test the service before continuing:

❖ If you choose “No, do not test,” click Next and skip to step 11.

❖ If you choose “Yes, perform a test,” click Next and proceed to step 9.

8 After clicking Next, the test will either succeed or fail:

❖ If the test is a success, please skip to step 11.

❖ If the test fails, proceed to step 10.

9 Click the Change Login button. Enter the default user name and 
password, then click OK. The test will run again:

❖ If the test is a success, click Next and proceed to step 11.

❖ If the test fails, contact your network administrator.

10 In the Net Service Name Configuration, Net Service Name window, enter 
the service name and click Next.

You are asked if you want to configure another net service name. Select 
No and click Next. The net service name configuration is complete.

Step 3d: ODBC Data Source Creation

In this step, you will create an ODBC Data Source named GIFTS. This data 
source is used by the Crystal Reports viewer included with GIFTS Alta to 
connect to the GIFTS Alta database on your Oracle server. GIFTS Alta and 
GIFTS Connections use a different ODBC driver to connect to the database, 
but use the DSN information in this data source to locate your database.
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Note: To complete this step, the Oracle ODBC drivers listed on the 
Compatibility Facts Sheet for your version of GIFTS Alta must reside on the 
workstation. In most cases (as described in the fact sheet), these drivers were 
installed by the GIFTS Alta Setup program.

To set up the workstation’s data source:

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

3 From the list of ODBC drivers, choose CR Oracle ODBC Driver 5.0 and click 
Finish. The ODBC Oracle Driver Setup window is displayed.

4 In the Data Source Name field, enter GIFTS.

5 In the Server Name field, enter the name of the database server you are 
using with GIFTS Alta.

6 Click OK and close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.

Step 3e: Microsoft Windows Configuration

If you are going to use GIFTS Alta to create merged correspondence in 
Microsoft Word, please use the following procedure to set up Microsoft 
Windows so that GIFTS Alta and Word can share data properly:

1 Go to Windows Start ➤ Computer to open the Windows Explorer.

2 From the Explorer menu, go to Organize ➤ Folder and search options, 
View ➤ Folder Options, or View ➤ Options (the name of the menu item 
is different depending on your version of Windows).

3 Click the View tab.

4 Ensure that the “Hide extensions for known file types” or “Hide MS-DOS 
file extensions for types that are registered” check box is not selected. Use 
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of this option can interfere with the way in which Microsoft Word merges 
data from GIFTS Alta.

Tip: After installing GIFTS Alta on any workstations running Windows 
Vista, and before logging into GIFTS Alta, you should give the workstation 
user full permissions to the gifts.ini file in the C:\WINDOWS directory. If 
you do not do this and log into GIFTS Alta, the updated gifts.ini file is stored 
in the following location: C:\Users\[user 
name]\AppData\Local\VirtualStore \Windows. If you need to make any 
changes to the gifts.ini file, do so from this location. This is only necessary 
for workstations running Windows Vista. 

If you make modifications to the GIFTS.ini in the 
C:\Users\[username]\AppData\Local\VirtualStore\Windows folder, please be 
sure to copy the same file to the C:\Windows folder so they match.

When you are finished with all three workstation installation tasks, you can 
proceed to the following section.
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Step 4: Populating the GIFTS Alta 
Database

This process creates the tables and system data for a new GIFTS Alta system. 
It must be run from a workstation that is already set up to run the client/
server version of GIFTS Alta.

Before You Begin: This process uses default parameters (like segment size) in the 
SQL Scripts it uses to create the database on your Oracle server. Your 
Database Administrator may wish to review these SQL Scripts and, if 
necessary, modify some of these parameters to improve performance. For 
more information, please refer to “Retrieving the Database Creation Scripts” 
on page 81.

1 Access the GIFTS folder and run the SQLInst.exe file.

2 Select the “Create Source Database on Target Server” option, then select 
the “Copy Source Data to Target Server” option.

The Source area should display the location of the GIFTS.MDB database 
file installed on the network server by Step 3a of the installation process.

Example: P:\GIFTS\GIFTS.MDB

This is a Microsoft Access version of the database; this process copies the 
database definitions to the GIFTS Alta database on your Oracle server.

3 In the Target area, confirm that Database reads GIFTS and that Data Source 
shows the network path to the database file. The Target area also displays 
the Login ID and Password for the GIFTS Alta database.

4 Click OK to begin. A process monitor displays progress information. Save 
the process report for future reference; you may need it later.

The installation of your database is complete, and you are ready to set up 
your workstations to use GIFTS Alta.
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Step 5: Installing the GIFTS Alta 
Workstations

This step consists of running the GIFTS Alta Workstation Installation, 
creating Oracle service to the workstation, setting up the appropriate ODBC 
data source, and configuring Windows to use correspondence templates 
correctly. The Workstation Installation must be run on every remaining 
workstation that is to have access to GIFTS.

Important: To use GIFTS, all users must have full network access rights to the 
GIFTS Alta directory on your file server.

Note: The GIFTS Alta workstation from which you performed “Step 3: 
Installing GIFTS ALTA on Your File Server” is already configured as a GIFTS 
Alta workstation.

Step 5a: Perform the Workstation Installation

This process uses the GIFTS Alta Setup program to install the files needed 
to run GIFTS Alta from this workstation. The Server Installation installed 
the Setup program on the network; be sure to run your workstation installations 
from the network, not from the Master folder on your original workstation.

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, then click 
Next. The Start Copying Files window opens.
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4 Read the summary provided of the installation options you chose. The 

Current Settings field should indicate that a “GIFTS Alta Workstation 
Installation” is to take place in the folder you specified.

If the options are correct, click Next. The installation begins.

5 If your workstation is not running a compatible version of the Microsoft 
Data Access Components (MDAC) software needed to run GIFTS Alta, 
you are prompted to install it. Click OK and follow the on-screen 
instructions to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the installation is complete, you are notified. Click Finish.

Step 5b: Oracle Service Creation

To establish Oracle Service for this GIFTS Alta workstation:

1 Open the Oracle Net Configuration Assistant.

2 In the Welcome screen, select the “Local Net Service Name 
configuration” option and click Next. The Net Service Name 
Configuration window opens.

3 Select the “Add” option and click Next. The Net Service Name 
Configuration, Database Version window opens.

4 Select the “Oracle 8i or later database or service” option and click Next. 
The Net Service Name Configuration, Service Name window opens.

5 In the Service Name field, enter the desired name (usually the database 
name). Click Next. The Net Service Name Configuration, Select Protocols 
window opens.

6 From the list, select the protocol for your network (contact your network 
administrator if you are unsure). Click Next. The Net Service Name 
Configuration, [Selected Protocol] window opens.
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7 Enter the host name and select the port number (use either the standard 

port number, or enter another one). Click Next. The Net Service Name 
Configuration, Test window opens.

8 Here, you may choose to test the service before continuing:

❖ If you choose “No, do not test,” click Next and skip to step 11.

❖ If you choose “Yes, perform a test,” click Next and proceed to step 9.

9 After clicking Next, the test will either succeed or fail:

❖ If the test is a success, please skip to step 11.

❖ If the test fails, proceed to step 10.

10 Click the Change Login button. Enter the user name and 
password, then click OK. The test will run again:

❖ If the test is a success, click Next and proceed to step 11.

❖ If the test fails, contact your network administrator.

11 In the Net Service Name Configuration, Net Service Name window, enter 
the service name and click Next.

You are asked if you want to configure another net service name. Select 
No and click Next. The net service name configuration is complete.

Step 5c: ODBC Data Source Creation

In this step, you will create an ODBC Data Source named GIFTS. This data 
source is used by the Crystal Reports viewer included with GIFTS Alta to 
connect to the GIFTS Alta database on your Oracle server. GIFTS Alta and 
GIFTS Connections use a different ODBC driver to connect to the database, 
but use the DSN information in this data source to locate your database.

Note: To complete this step, the Oracle ODBC drivers listed on the 
Compatibility Facts Sheet for your version of GIFTS Alta must reside on the 
workstation. In most cases (as described in the fact sheet), these drivers were 
installed when you installed GIFTS Alta.
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To create the data source:

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

3 From the list of ODBC drivers, choose CR Oracle ODBC Driver 5.0 and click 
Finish. The ODBC Oracle Driver Setup window is displayed.

4 In the Data Source Name field, enter GIFTS.

5 In the Server Name field, enter the name of the database server you are 
using with GIFTS Alta.

6 Click OK and close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.

Step 5d: Microsoft Windows Configuration

If you are going to use GIFTS Alta to create merged correspondence in 
Microsoft Word, please use the following procedure to set up Microsoft 
Windows so that GIFTS Alta and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista, from the Explorer menu, choose Organize ➤ 
Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS Alta.
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Step 5e: Microsoft Word 2010 Trusts

Microsoft introduced the Trust Center functionality in Office 2010. This 
requires special configuration on each workstation installed with Office 
2010 in order to properly use GIFTS Alta correspondence templates. 

Please follow the steps below: 

1 Open Microsoft Word 2010 and go to File > Options > Trust Center

2 Click the Trust Center Settings... button

3 Click Trusted Locations on the left panel

4 Check Allow Trusted Locations on my network option

5 Click Add new location...

6 Add the GIFTS Alta folder as a new location (usually C:\GIFTS)

7 Check the box for Subfolders of this location are also trusted.

If the above does not resolve the issue, in the Trust Center window, click File 
Block Settings in the left panel. Some settings that dictate what files the 
Trust Center will block may need to be unchecked as well. 

When you are finished with all workstation installation tasks, your GIFTS 
Alta installation should be complete. Remember that to use GIFTS Alta, all 
users must have full access rights to the GIFTS Alta directory on your file 
server.
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Step 6: Logging in to GIFTS Alta for the 
First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS Alta workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS Alta 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
Alta for your organization, as described in the GIFTS Alta Administrator’s 
Guide.
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Retrieving the Database Creation Scripts

Important: The information in this section applies only to users who wish to 
review or modify the scripts used by the SQLINST.EXE utility to populate 
the Oracle database (as described in “Step 4: Populating the GIFTS ALTA 
Database” on page 74).

To save the SQL Scripts used by the SQLINST.EXE utility as a text file:

1 Access the GIFTS folder and run the SQLInst.exe file.

2 Check the Create SQL Scripts option and choose where you wish the 
scripts to be saved.

3 Ensure that the “Create Source Database on Target Server” and “Copy 
Source Data to Target Server” options are not selected.

4 Click OK. The scripts are displayed and saved to the file you specified.

Important: When you create the database tables, ensure that you are logged 
in as the default user. If you do not use the default user, processes that 
identify the tables by their owner as well as their name—including the 
loading of converted data and the running of all GIFTS Alta reports—will 
fail.
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Before You Begin

The following important points should be addressed before you install GIFTS 
Alta:

❖ Please make sure to read these instructions carefully. You should 
understand the entire installation process before you begin.

❖ Please make sure you have access to the services of a trained network 
administrator familiar with all aspects of setting up and administering the 
Microsoft Terminal Server and Citrix Presentation Server environments. 
MicroEdge Technical Support personnel cannot provide advice or 
assistance related to the setup of Terminal Server and Citrix.

❖ Ensure that your server operating system and Citrix software are 
compatible with GIFTS Alta. To obtain the latest compatibility 
information for GIFTS Alta, please go to http://www.microedge.com and 
log in to GIFTS PowerME.

The above points are vital towards ensuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.
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Citrix Installation Options for Your Server

The instructions in this chapter describe two possible installation scenarios 
for using GIFTS Alta with Citrix Presentation Server: 

❖ Installing GIFTS Alta Workstation Software on Your Citrix Server – 
this procedure describes how to install the GIFTS Alta workstation 
software on a computer running Terminal Services with Citrix. This 
procedure may be used by clients with file server or client/server 
configurations of GIFTS Alta, including clients who have already installed 
their GIFTS Alta system on other computers. See “Option 1: Installing a 
GIFTS Alta Workstation” on page 86.

❖ Installing a Standalone GIFTS Alta System on Your Citrix Server – this 
option is for clients who wish to install their entire GIFTS Alta system on 
a single computer running Terminal Services with Citrix, and to make 
GIFTS Alta available to other users through Citrix Presentation Server. 
See “Option 2: Installing a Standalone System” on page 90.

To inquire about other possible options for installing GIFTS Alta with Citrix, 
please contact MicroEdge Technical Support.
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Option 1: Installing a GIFTS Alta 
Workstation

This procedure describes how to install the GIFTS Alta workstation 
software on a computer running Windows Terminal Services to provide 
access to GIFTS Alta through Citrix Presentation Server.

Step 1: Install Your GIFTS Alta System

The first step is to install all parts of the GIFTS Alta system except the 
workstation that you plan to use to provide access through Citrix 
Presentation Server. To install GIFTS Alta, please follow the instructions for 
your system configuration:

❖ Clients with a file server system should refer to the instructions in “New 
GIFTS Alta Standalone or File Server Installation” on page 23.

❖ Clients installing GIFTS Alta in a SQL Server environment should follow 
the instructions in “New Microsoft SQL Server Installation” on page 37.

❖ Clients installing GIFTS Alta in an Oracle server environment should 
follow the instructions in“New Oracle Server Installation” on page 59.

Note: If you wish to install GIFTS Alta on a single computer only, please refer 
to “Option 2: Installing a Standalone System” on page 90.

Step 2: Disabling Remote Logons

Note: MicroEdge does not provide support for Citrix Presentation Server or 
Microsoft Windows. The following steps are included as a guideline for 
performing steps necessary to the installation of GIFTS Alta. The interface of 
Windows or Citrix may vary, as determined by the versions of the software 
that you are running.

Important: You must perform this step from the server console.
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In this procedure, you will disable remote logons to your Citrix Presentation 
Server, which is a prerequisite to installing the GIFTS Alta workstation 
software on your Terminal Server:

1 Log on to the server as a member of the local Administrators group.

2 Use the Windows Start menu to open the Presentation Server Console: 
select All Programs ➤ Citrix ➤ Management Consoles ➤ Presentation 
Server Console.

3 Highlight the server in the server list.

4 Ensure that there are no remote sessions running.

5 Right-click the server name, and select Properties from the menu. The 
server’s properties are displayed.

6 In the left column, select Metaframe Settings.

7 In the right column, turn off the option to “Allow logons to this server.”

8 Click OK to save the server properties.

9 Close the Management Console.

You can now proceed to the next step to install the GIFTS Alta workstation 
software on your Presentation Server.

Step 3: Installing GIFTS Alta on Your Presentation 
Server

Before You Begin: Please review the following important information regarding 
the installation of GIFTS Alta with Citrix:

❖ You must launch the GIFTS Alta Setup program from within the Add/
Remove Programs Control Panel, as described in this procedure. If you 
do not run GIFTS Alta Setup from within the Control Panel, GIFTS Alta 
will not run under Terminal Services.

❖ If you are prompted to restart the computer during the installation 
procedure, choose to restart later. You must complete the entire GIFTS 
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Alta installation process and close the Add/Remove Programs utility 
before restarting the computer.

❖ At the conclusion of the GIFTS Alta Setup process, you should close the 
Add/Remove Programs utility before proceeding; make sure that the 
GIFTS Alta installation is complete before closing the utility.

To install GIFTS Alta on your server:

1 From the Windows Start menu, choose Control Panel ➤ Install 
Application from Remote Desktop.

2 Browse to and run the Setup.exe program located in the GIFTS\Setup 
directory of your GIFTS Alta file server.

Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta installation process begins.

3 You may now install GIFTS Alta, as described in the section that applies 
to your configuration:

Important Reminder: You must run the GIFTS Alta Setup program from within 
the Add/Remove Programs Control Panel.

❖ File server installations – please refer to “About the File Server 
Installation Process” on page 25. 

❖ SQL Server installations – please refer to “New Microsoft SQL 
Server Installation” on page 37.

❖ Oracle Server installations – please refer to “Overview of the 
Installation Process” on page 62.

When you have finished installing the GIFTS Alta workstation software 
(including the steps for configuring Microsoft Windows and, for client/
server systems, creating an ODBC data source), you may proceed to the 
next step.
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Step 4: Copying the GIFTS Alta Help Files

This procedure describes how make the GIFTS Alta help files available to 
users who access GIFTS Alta through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following GIFTS Alta help files:

3 Paste the GIFTS Alta help files to the virtual WINDOWS directory of each 
user who uses GIFTS Alta through Citrix. The locations of these virtual 
directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS Alta help files are now available to your users. Please continue to 
the next step to complete your installation.

Step 5: Completing Your Installation

To complete your installation, publish GIFTS Alta on your Presentation 
Server according to your organization’s policies and the instructions 
provided by Citrix. Then, just re-enable logons to your server and your 
installation of GIFTS Alta with Citrix is complete! 

empadmin.chm gfwbudget.chm

empgifts.chm gfwgam.chm

gfwadmin.chm gifts.chm

gfwap.chm mesupp.chm

altagifts.chm gfw60.chm
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Option 2: Installing a Standalone System

This procedure describes how to install a standalone GIFTS Alta system on a 
computer running Citrix Presentation Server to provide access to GIFTS 
Alta through Citrix. Using this procedure, all components of GIFTS Alta will 
be installed on the computer—including the GIFTS Alta database. This 
option is not intended for client/server systems.

Step 1: Disabling Remote Logons

Before installing GIFTS Alta, you should disable remote logons to your 
Citrix Presentation Server. To do so, please follow the instructions in “Step 
2: Disabling Remote Logons” on page 86 and proceed to the next step.

Step 2: Copying Your GIFTS Alta Configuration 
File

This procedure describes how to copy the configuration file for your GIFTS 
Alta system from your extracted GIFTS Alta Installation Files to your 
Terminal Server. This file must be available during the installation process.

1 Access the location where you extracted the GIFTS Alta Installation Files.

2 Copy the gifts.cfg file to a convenient location on your local hard drive. 
Make a note of this location: you will need to know it when you install 
GIFTS Alta.

3 Right-click on your new copy of the gifts.cfg file and select Properties.

4 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

5 Click OK to save the gifts.cfg properties.

Please proceed to the next step to install the GIFTS Alta software.
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Step 3: Installing GIFTS Alta

Before You Begin: Please review the following important information regarding 
the installation of GIFTS Alta with Citrix:

❖ You must launch the GIFTS Alta Setup program from within the Add/
Remove Programs Control Panel, as described in this procedure. If you 
do not run GIFTS Alta Setup from within the Control Panel, GIFTS Alta 
will not run under Terminal Services.

❖ If you are prompted to restart the computer during the installation 
procedure, choose to restart later. You must complete the entire GIFTS 
Alta installation process and close the Add/Remove Programs utility 
before restarting the computer.

❖ At the conclusion of the GIFTS Alta Setup process, you should close the 
Add/Remove Programs utility before proceeding; make sure that the 
GIFTS Alta installation is complete before closing the utility.

To install a standalone GIFTS Alta system on your Terminal Server:

1 From the Windows Start menu, choose Control Panel ➤ Install 
Application from Remote Desktop.

2 Browse to the location of the Master/Install folder and run the Setup.exe 
file. The GIFTS Alta installation process begins.

Important Reminder: You must run the GIFTS Alta Setup program from within 
the Control Panel.

3 You may now continue with your GIFTS Alta installation. To do so, please 
follow the steps in “About the Standalone Installation Process” on page 24.

When you have finished installing GIFTS Alta (including the steps for 
configuring Microsoft Windows), you may proceed to the next step.

Step 4: Copying the GIFTS Alta Help Files

To make the GIFTS Alta online help available to each user, please follow the 
instructions in “Step 4: Copying the GIFTS Alta Help Files” on page 89. 
Then, proceed to the next step of this procedure to complete your 
installation. 
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Step 5: Completing Your Installation

To complete your installation, publish GIFTS Alta on your Presentation 
Server according to your organization’s policies and the instructions 
provided by Citrix. Then, just re-enable logons to your server and your 
installation of GIFTS Alta with Citrix is complete! 
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Before You Begin

The following important points should be addressed before you install 
GIFTS Alta:

❖ Please make sure to read these instructions carefully. You should 
understand the entire installation process before you begin.

❖ Please make sure you have access to the services of a trained network 
administrator familiar with all aspects of setting up and administering the 
Microsoft Terminal Server environment. MicroEdge Technical Support 
personnel cannot provide advice or assistance related to the setup of 
Terminal Server.

❖ Ensure that your server operating system is compatible with GIFTS Alta. 
To obtain the latest compatibility information for GIFTS Alta, please go 
to http://www.microedge.com and log in to GIFTS PowerME.

❖ IMPORTANT: GIFTS Alta must already be installed on a File Server to 
begin installation on a Terminal Server. For more information on file 
server installation, refer to the File Server Installation section on page 30 
of the GIFTS Alta Installation Guide.

The above points are vital towards ensuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.
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Installing GIFTS Alta on Your Terminal 
Server

This procedure describes how to install GIFTS Alta system on a computer 
running Terminal Services to provide access to GIFTS Alta. Using this 
procedure, all components of GIFTS Alta will be installed on the computer-
including the GIFTS Alta database.

Step 1: Terminal Server Installation

1 From a workstation with network access, go to Start > All Programs > 
Accessories > Remote Desktop Connection. 

2 Enter your Terminal Server address and click Connect.

3 Login to your Terminal Server.

4 Go to Start > Control Panel.

5 On the Control Panel, click on Install Application on Remote Desktop 
Server.

6 If a User Account Control warning prompt is displayed, click Yes.

7 When the Install Program From Floppy Disk or CD-ROM prompt 
appears, click Next.

8 On the Run Installation Program prompt, click Browse.

9 Navigate to your file server and locate the Setup.exe file. (usually in the 
GIFTS\Setup folder)

10 Select the Setup.exe file and click Open.

11 Click Next to continue.

12 When the Open File - Security Warning prompt appears, click Run.

13 Follow the GIFTS Alta installation wizard.

14 When the GIFTS Alta installation is complete, click Finish.
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15 Close the Control Panel window.

16 Go to Start > All Programs and you should see a MicroEdge GIFTS folder.

Step 2: Publish the Application to Terminal 
Services

1 Go to Start > Administrative Tools > Remote Desktop Services and 
select RemoteApp Manager.

2 On the right side panel under Actions, click on Add RemoteApp 
Programs.

3 When the RemoteApp Wizard opens, click Next.

4 On the programs list, check the boxes next to GIFTS Alta and any other 
related modules.

5 Click Next to continue.

6 Review your selections on the Review Settings window then click Finish.

7 The programs you selected should now be listed on the RemoteApp 
Programs list on the bottom of the RemoteApp Manager window.

Step 3: Test and Configure Remote Web Access

1 Go to Start > Administrative Tools > Remote Desktop Services and 
click on Remote Desktop WebAccess Configuration.

2 Login to the Remote Desktop Services Default Connection.

3 You should see all the RemoteApp program icons displayed.

4 Click on the GIFTS Alta icon.

5 A RemoteApp warning prompt will appear. Click Connect to continue.

6 Login using your network credentials.
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7 When the Open File - Security Warning appears, click Run.

8 GIFTS Alta will now open as normal and request your login.

Note: For more information about setting up RemoteApps for users, see 
http://technet.microsoft.com/en-us/library/cc730673(v=ws.10).aspx
Installing GIFTS Alta on Your Terminal Server 97



New Installation of GIFTS Alta with Terminal Server6
98 Installing GIFTS Alta on Your Terminal Server



7 Upgrading a
GIFTS Alta

Standalone
Workstation

or File Server
This chapter describes how to upgrade GIFTS Alta on a standalone 
system or a file server system.

In This Chapter
Before You Begin..................................................................100

Standalone Upgrade .............................................................103

File Server Upgrade ..............................................................107



Upgrading a GIFTS Alta Standalone Workstation or File Server7

Before You Begin

This process upgrades your GIFTS 6.4 or later, or previous version of Alta 
system to the most recent GIFTS Alta. To determine which version you 
have in GIFTS 6.x, go to Help: About. To determine which version you have 
in GIFTS Alta, go to the User Menu: About Alta.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

The following important points should be addressed before you upgrade 
GIFTS:

❖ Your GIFTS program files, database, reports, and template files are altered 
by this process. Please make a complete backup of your current GIFTS 
directory (including your database) before proceeding.

❖ All users must be logged out of GIFTS Alta for the duration of your 
upgrade.

❖ Upgrading GIFTS Alta can take a significant amount of time depending 
how large your current installation is. 

❖ If you use MyGIFTS or ReviewerCONNECT, it must be version 3.6 or 
higher. Otherwise, you will have to upgrade to GIFTS Connections 3.6 at 
the conclusion of your GIFTS Alta upgrade. Please review the GIFTS 
Connections: MyGIFTS and ReviewerCONNECT Installation and Technical 
Reference Guide and consider your upgrade of GCS when planning the time 
and resources needed to complete your upgrade.

❖ If you are using any virus-protection software, please disable it before you 
upgrade GIFTS Alta. Virus-protection programs may cause errors during 
the upgrade process.

❖ If Crystal Reports is installed on your system, be sure to read 
“Compatibility with Crystal Reports” on page 184.
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❖ Read the following sections, “About the Standalone Upgrade” and “About 

the File Server Upgrade”, to determine which type of upgrade you need 
to perform.

The points above are vital to ensuring that your upgrade is successful. Please 
make sure that each issue has been thoroughly addressed before continuing.

About the Standalone Upgrade

This type of upgrade is for clients who have a single-user version of GIFTS 
Alta installed on a single workstation. To perform this type of upgrade, 
please refer to “Standalone Upgrade” on page 103.

About the File Server Upgrade

This upgrade is for systems where GIFTS Alta is installed on a network file 
server that is accessible from one or more GIFTS Alta workstations.

This upgrade includes a Server Upgrade process—which upgrades the shared 
files and GIFTS Alta database on the server—and a Workstation Upgrade 
which upgrades the files on each GIFTS Alta workstation. To perform this 
type of upgrade, please refer to “File Server Upgrade” on page 107.

Note: If you have a Microsoft SQL Server or Oracle server backend, please 
refer to “Upgrading GIFTS Alta Client/Server Installations” on page 113 for 
upgrade instructions.

System Files

For a complete list of the system files installed by the GIFTS Alta upgrade, 
consult the “GIFTS Alta Impact Analysis” on page 176.
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How to Obtain Technical Support

If you have any difficulties during this process, please contact MicroEdge 
Technical Support in one of the following ways:

❖ by creating a New Case on PowerME. Go to 
http://www.microedge.com and log in to the PowerME support website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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Standalone Upgrade

This type of upgrade is for clients who have purchased a single-user version 
of GIFTS Alta and who have installed the entire GIFTS Alta system on the 
hard drive of a single workstation.

Step 1: Upgrading Your GIFTS Alta Configuration 
File

If you received a new Configuration File from MicroEdge with your 
upgrade, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
File with their upgrade package; most clients do not receive a new Configuration 
File. If you did not receive a Configuration File, please skip to “Step 2: 
Upgrading Program Files”.

To update your GIFTS Alta configuration file:

1 Copy the gifts.cfg file to the \GIFTS directory on your workstation. A 
message warns that you are overwriting an existing file. Click Yes to 
continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.
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Step 2: Upgrading Program Files

Before You Begin: To avoid software conflicts, please close all other applications 
on the workstation before proceeding.

To upgrade your standalone GIFTS Alta workstation:

1 Refer to the Upgrade email sent to you by MicroEdge and follow the 
instructions for downloading the Upgrade Installation Files. 

Note: Save the downloaded file(s) to a location on your workstation or 
server that will be easy to find. 

2 Once the download is complete, extract all files from the zip file(s).

3 Navigate to the Master/Install folder for GIFTS Alta and double-click the 
Setup.exe file. Click Run at the Security Warning prompt.

4 At the MicroEdge GIFTS Alta Installation Wizard window, click Next. 
The Select Setup Type window opens.

Note: Throughout the upgrade, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.

5 Select the “Local Installation (single user)” option and click Next. The 
Select Program Folder window opens.

6 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, and click 
Next. The Start Copying Files window opens.

7 Read the summary provided of the upgrade options you chose. The 
Current Settings field should indicate that a “Local GIFTS Alta 
Installation” is to take place in the folder you specified; the following line 
should note that this is an “Upgrade of an existing installation.”

If the options are correct, click Next to begin the upgrade.

The install process may involve up to four steps depending what is 
currently installed on the workstation or server.

❖ Install Alta program files

❖ Install Crystal Reports v11 files (if not currently installed)
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❖ Install .Net 4 Framework (if not currently installed)

❖ Install MS Data Access Components (MDAC) (if not currently 
installed)

If your computer is not running a compatible version of above software 
needed to run GIFTS Alta, you are prompted to install it. Click OK and 
follow the on-screen instructions to complete the installation from your 
downloaded files.

Note: After the installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 8.

8 When the upgrade is complete, the Setup Complete window opens. 

Important: The following database upgrade makes irreversible changes to your 
database. Before proceeding, make sure that you have a current backup of 
your database.

9 In the Setup Complete window you are given the option to upgrade your 
GIFTS Alta database.

Important: If the Setup Complete window with the message prompting you 
to perform the database upgrade does not appear, go to “Step 3: Manually 
Upgrading the Database” on page 106 and run the database upgrade 
manually.

If you want to run the database upgrade now, select the Run GIFTS Alta 
Database Upgrade check box and click Finish. 

Tip: The database upgrade can take a significant amount of time to 
complete depending on the current size of your database.

❖ If you have not backed up your current database, or want to perform 
the database upgrade later for any reason, clear the check box and 
click Finish. Use instructions found in “Step 3: Manually Upgrading 
the Database” on page 106 to run the upgrade yourself after backing 
up the database.

(If the message prompting you to perform the database upgrade does not 
appear, go to “Step 3: Manually Upgrading the Database” on page 106 and 
run the database upgrade manually.)
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Congratulations! If you have performed the database upgrade, your upgrade 
is complete, and you may resume your use of GIFTS Alta.

Step 3: Manually Upgrading the Database

Note: Upgrading the database can take a significant amount of time to 
complete. Please take this into consideration when scheduling your upgrade.

Follow the instructions below only if you did not upgrade the database at the 
end of the process described in “Step 2: Upgrading Program Files” on 
page 104.

!
Caution: The database upgrade makes irreversible changes to your GIFTS 
Alta database. Before proceeding, make sure that you have a current backup 
of your database.

To upgrade your GIFTS Alta database for use with GIFTS Alta:

1 From the Windows Start menu, select Run.

2 Browse to locate the GIFTS Alta Master/Install folder and double-click 
on the Setup.exe file. This will essentially run through the GIFTS Alta 
install again.

3 When you reach the Setup Complete window, make sure the Run GIFTS 
Alta Database Upgrade check box is selected and and click Finish to run 
the upgrade.

4 A process log indicates the progress of the upgrade, and a message 
indicates when the upgrade has successfully completed. Click OK to 
continue.

If you receive a message that the upgrade did not complete successfully, 
click Print or Save As to keep the log and fax it to MicroEdge Technical 
Support at (212) 757-1784 or email it to helpdesk@microedge.com.

Congratulations! Your GIFTS Alta upgrade is complete, and you may 
resume your use of GIFTS Alta.
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File Server Upgrade

This type of upgrade is for GIFTS Alta systems installed on a network file 
server and one or more GIFTS Alta workstations.

In a network environment, the database, program files, and report and 
correspondence templates that reside on your file server must be upgraded 
first. This part of the upgrade is the Server Upgrade, and it is run only once. 
The server upgrade can be run from any GIFTS Alta workstation using the 
MicroEdge GIFTS Alta Upgrade Installation Files. 

The Server Upgrade includes the following steps:

❖ “Step 1: Updating Your GIFTS ALTA Configuration File” on page 107

❖ “Step 2: Upgrading the GIFTS ALTA File Server” on page 108

❖ “Step 3: Manually Upgrading the GIFTS Alta Database” on page 110

❖ “Step 4: Upgrading Other GIFTS ALTA Workstations” on page 111

The workstation setup program is placed on the file server during the server 
upgrade, and should be used for all workstation upgrades.

Step 1: Updating Your GIFTS Alta Configuration 
File

If you received a new Configuration file from MicroEdge with your 
upgrade, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
file with their upgrade package; most clients do not receive a new Configuration 
file. If you did not receive a Configuration file, please skip to “Step 2: 
Upgrading the GIFTS ALTA File Server”.
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To update your GIFTS Alta configuration file:

1 Copy the gifts.cfg file to the \GIFTS directory on your GIFTS Alta file 
server. A message warns that you are overwriting an existing file. Click 
Yes to continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Step 2: Upgrading the GIFTS Alta File Server

This process will upgrade your GIFTS Alta file server and the workstation 
from which you run the upgrade process. The upgrade process also gives 
you the option to run the GIFTS Alta database upgrade.

Important: This process must be performed from a workstation already 
configured to run GIFTS Alta. Please be sure that the workstation has at 
least 25MB of available disk space for temporary files. The upgrade may not 
complete successfully if the workstation does not have sufficient disk space.

To upgrade your GIFTS Alta file server and the current workstation:

1 Refer to the Upgrade email sent to you by MicroEdge and follow the 
instructions for downloading the Upgrade Installation Files. 

Note: Save the downloaded file(s) to a location on your workstation or 
server that will be easy to find. 

2 Once the download is complete, extract all files from the zip file(s).

3 Navigate to the Master/Install folder for GIFTS Alta and double-click the 
Setup.exe file. Click Run at the Security Warning prompt.

4 At the MicroEdge GIFTS Alta Installation Wizard window, click Next. 
The Select Setup Type window opens.

Note: Throughout the upgrade, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.
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5 Select the “Network Installation” option and click Next. The Select 

Program Folder window opens.

6 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, and click 
Next. The Start Copying Files window opens.

7 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Alta Server 
Installation” is to take place in the folder you specified; the following line 
should note that this is an “Upgrade to an existing installation.”

If the options are correct, click Next to begin the upgrade.

The install process may involve up to four steps depending what is 
currently installed on the workstation or server.

❖ Install Alta program files

❖ Install Crystal Reports v11 files (if not currently installed)

❖ Install .Net 4 Framework (if not currently installed)

❖ Install MS Data Access Components (MDAC) (if not currently 
installed)

If your computer is not running a compatible version of above software 
needed to run GIFTS Alta, you are prompted to install it. Click OK and 
follow the on-screen instructions to complete the installation from your 
downloaded files.

Note: After the installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 8.

8 When the upgrade is complete, a message opens, indicating that you must 
run the GIFTS Alta Database Upgrade before you can use GIFTS Alta.

Important: The following database upgrade makes irreversible changes to 
your database. Before proceeding, make sure that you have a current 
backup of your database. 

Important: If the Setup Complete window with the message prompting you 
to perform the database upgrade does not appear, go to “Step 3: Manually 
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Upgrading the GIFTS Alta Database” on page 110 and run the database 
upgrade manually.

❖ If you have not backed up your current database, clear the check box 
and click Finish. Use instructions found in “Step 3: Manually 
Upgrading the GIFTS Alta Database” on page 110 to run the upgrade 
yourself after backing up the database.

❖ If you want to run the database upgrade now, select the “Run GIFTS 
Alta Database Upgrade” check box and click Finish to run the 
upgrade. 

Note: Note that the database upgrade can take a significant amount of time 
to complete.

Once the database upgrade is complete, you can proceed to “Step 4: 
Upgrading Other GIFTS ALTA Workstations” on page 111.

Step 3: Manually Upgrading the GIFTS Alta 
Database

Important: This upgrade needs to be run only once: If you chose to upgrade 
your database at the end of the preceding step, you may skip this section and 
proceed to “Step 4: Upgrading Other GIFTS ALTA Workstations” on 
page 111.

This step updates the structure of your GIFTS Alta database and performs 
data updates to make your database compatible with GIFTS Alta. Users will 
not be able to log in to GIFTS Alta until the database is upgraded.

Note: Upgrading the database can take a significant amount of time to 
complete. Please take this into consideration when scheduling your database 
upgrade.

This process must be run on a workstation already configured for GIFTS 
Alta. Either run it from the same workstation you used for “Step 2: 
Upgrading the GIFTS ALTA File Server”, or upgrade a workstation 
according to the instructions in “Step 4: Upgrading Other GIFTS ALTA 
Workstations” on page 111, then use it to run the database upgrade 
following the directions in this section.
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!

Caution: The database upgrade makes irreversible changes to your database. 
Before proceeding, make sure that you have a current backup of your 
database.

1 At the workstation you just upgraded in Step 3, open the Windows Start 
menu and select Run.

2 Browse to locate the GIFTS Alta Master/Install folder and double-click 
on the Setup.exe file. This will essentially run through the GIFTS Alta 
install again.

3 When you reach the Setup Complete window, make sure the Run GIFTS 
Alta Database Upgrade check box is selected and and click Finish to run 
the upgrade.A process log indicates the progress of the upgrade, and a 
message indicates when the upgrade has successfully completed. Click OK 
to continue.

If you receive a message that the upgrade did not complete successfully, 
click Print or Save As to keep the log and fax it to MicroEdge Technical 
Support at (212) 757-1784 or email it to helpdesk@microedge.com.

Step 4: Upgrading Other GIFTS Alta Workstations

The next step is to perform the Workstation Upgrade on your remaining 
GIFTS Alta workstations. This process updates the workstation files needed 
to run GIFTS Alta.

The GIFTS Alta Workstation Upgrade must be run on every workstation that 
has access to GIFTS Alta—except the GIFTS Alta workstation used for “Step 
2: Upgrading the GIFTS ALTA File Server” on page 108. That workstation 
was upgraded during the file server upgrade process.

Important: The workstation upgrade must be run from a network copy of the 
Setup program.
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To upgrade a workstation:

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, and click 
Next. The Start Copying Files window opens.

4 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Alta Workstation 
Installation” is to take place in the folder you specified; the following line 
should note that this is an “Upgrade to an existing installation.”

If the options are correct, click Next. The upgrade begins.

5 If the workstation is not running a compatible version of the Microsoft 
Data Access Components (MDAC) software needed to run GIFTS Alta, 
you are prompted to install it. Click OK and follow the on-screen 
instructions to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the upgrade is complete, you are notified. Click Finish.

Congratulations! After performing upgrades to all GIFTS Alta workstations, 
your GIFTS Alta upgrade is complete. You may resume your use of GIFTS 
Alta.

Important: If you have a version of MyGIFTS or ReviewerCONNECT earlier 
than 3.5, you now need to upgrade GIFTS Connections to verison 3.6. 
Please refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT 
Installation and Technical Reference Guide for more information.
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Before You Begin

This process upgrades your GIFTS 6.4 or later, or previous version of Alta 
system to the most recent GIFTS Alta.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

The following important points should be addressed before you upgrade 
GIFTS:

❖ Your program, database, reports, and template files are altered by this 
process. Before proceeding, make a complete backup of your GIFTS 
database—as well as the GIFTS directory on your file server.

❖ All users must be logged out of GIFTS Alta for the duration of the upgrade.

❖ Upgrading GIFTS Alta can take a significant amount of time depending 
how large your current installation is. 

❖ If you use MyGIFTS or ReviewerCONNECT, it must be version 3.6 or 
higher. Otherwise, you will have to upgrade to GIFTS Connections 3.6 at 
the conclusion of your GIFTS Alta upgrade. Please review the GIFTS 
Connections: MyGIFTS and ReviewerCONNECT Installation and Technical 
Reference Guide and consider your upgrade of GCS when planning the time 
and resources needed to complete your upgrade.

❖ If you are using any virus-protection software, please disable it before you 
upgrade GIFTS Alta. Virus-protection programs may cause errors during 
the upgrade process.

❖ If Crystal Reports is installed on your system, be sure to read 
“Compatibility with Crystal Reports” on page 184.

The points above are vital to ensuring that your upgrade is successful. Please 
make sure that each issue has been thoroughly addressed before continuing.
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System Files

For a complete list of the system files installed by the GIFTS Alta setup 
process, consult the “Installation Impact Analysis” on page 175.

How to Obtain Technical Support

If you have any difficulties during this process, please contact MicroEdge 
Technical Support in one of the following ways:

❖ by creating a New Case on PowerME. Go to 
http://www.microedge.com and log in to the PowerME support website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784

The procedures outlined below will take you through the process of 
upgrading the GIFTS Alta client/server edition for Microsoft SQL Server or 
Oracle server.
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Overview of the Upgrade Process

The upgrade process includes four major steps:

Step 1: Important Prerequisites The preparation steps are essential for 
ensuring that the upgrade process runs properly.

Step 2: Upgrading the File Server This process upgrades shared files on the 
network server, including the program and report files, and is run only once. 
The server upgrade must run from a GIFTS Alta workstation.

Step 3: Manually Upgrading the GIFTS Alta Database This process upgrades 
the structure of the database on the database server, including the addition 
of new fields required by GIFTS Alta. This part of the upgrade is run only 
once.

Step 4: Upgrading Your GIFTS ALTA Workstations This process upgrades your 
remaining workstations. This part of the upgrade must be run on every 
workstation that has access to GIFTS Alta.

To complete the upgrade, you must complete these steps in the order in 
which they are presented. 

Note: Clients with MyGIFTS or ReviewerCONNECT should upgrade GIFTS 
Connections after completing the GIFTS Alta upgrade process. Please refer 
to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation and 
Technical Reference Guide for more information.
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Step 1: Important Prerequisites

Before beginning the upgrade, make sure your network environment and 
GIFTS Alta configuration are ready.

Preparing Your Environment

Upgrading to GIFTS Alta alters your program, database, reports, and 
template files. The following important points should be addressed before 
you perform the upgrade:

❖ Make a complete backup of your current GIFTS Alta directory and the 
GIFTS Alta database on your Microsoft SQL or Oracle server.

❖ Microsoft SQL Server users should run the DBCC CHECKDB function 
(database consistency check) to locate and correct errors in the logical or 
physical consistency of the GIFTS Alta database. For more information 
about this process, please consult your SQL Server documentation.

❖ Ensure that your database server is compatible with GIFTS Alta. 

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet 
on the GIFTS PowerME site for comprehensive compatibility 
information. Search for ‘Compatibility Facts Sheet’ and select the latest 
document for your version of GIFTS Alta.

❖ GIFTS Alta connects to the database server using ODBC drivers, which 
are installed during the upgrade process. 
To check the version of the ODBC driver installed on a workstation, you 
can use the “Data Sources (ODBC)” Control Panel.

❖ If you are using any virus-protection software, please make sure that it is 
disabled before you run the upgrade. An active virus-protection program 
may cause errors during the upgrade process.

❖ If you use or intend to use Crystal Reports, make sure to read 
“Compatibility with Crystal Reports” on page 184.

❖ GIFTS Alta requires a comparable amount of hard disk space to previous 
versions of GIFTS. Please refer to “GIFTS Alta Storage Requirements” on 
page 7 for more information.
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Important: The above points are vital to ensuring that your upgrade is 
successful. Please make sure that each issue has been thoroughly addressed 
before you continue.

Updating Your GIFTS Alta Configuration File

If you received a new Configuration file from MicroEdge with your upgrade 
download, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
file with their upgrade package; most clients do not receive a new Configuration 
file. If you did not receive a Configuration File, please proceed to “Step 2: 
Upgrading the File Server” on page 119.

To update your GIFTS Alta configuration file:

1 Copy the gifts.cfg file to the \GIFTS directory on your GIFTS Alta file 
server. A message warns that you are overwriting an existing file. Click 
Yes to continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.
118 Step 1: Important Prerequisites



Upgrading GIFTS Alta Client/Server Installations8

Step 2: Upgrading the File Server

You can run the file server upgrade process from any GIFTS Alta 
workstation. The setup process uses the information contained in the 
workstation’s gifts.ini file to determine the location of your current GIFTS 
Alta system, and upgrades it accordingly.

Please note that the workstation from which you run the file server upgrade 
is also upgraded to a GIFTS Alta workstation during this process.

Before You Begin: Please be sure that the workstation from which you are 
running the server upgrade has at least 25MB of available disk space for 
temporary files. The server upgrade may not complete successfully if the 
workstation does not have sufficient disk space.

To upgrade your GIFTS Alta file server and the current workstation:

1 Refer to the Upgrade email sent to you by MicroEdge and follow the 
instructions for downloading the Upgrade Installation Files. 

Note: Save the downloaded file(s) to a location on your workstation or 
server that will be easy to find. 

2 Once the download is complete, extract all files from the zip file(s).

3 Navigate to the Master/Install folder for GIFTS Alta and double-click the 
Setup.exe file. Click Run at the Security Warning prompt.

4 At the MicroEdge GIFTS Alta Installation Wizard window, click Next. 
The Select Setup Type window opens.

Note: Throughout the upgrade, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.

5 Select the “Network Installation” option and click Next. The Select 
Program Folder window opens.

6 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, and click 
Next. The Start Copying Files window opens.
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7 Read the summary provided of the installation options you chose. The 

Current Settings field should indicate that a “GIFTS Alta Server 
Installation” is to take place in the folder you specified; the following line 
should note that this is an “Upgrade to an existing installation.”

If the options are correct, click Next. The upgrade begins.

IThe install process may involve up to four steps depending what is 
currently installed on the workstation or server.

❖ Install Alta program files

❖ Install Crystal Reports v11 files (if not currently installed)

❖ Install .Net 4 Framework (if not currently installed)

❖ Install MS Data Access Components (MDAC) (if not currently 
installed)

If your computer is not running a compatible version of above software 
needed to run GIFTS Alta, you are prompted to install it. Click OK and 
follow the on-screen instructions to complete the installation from your 
downloaded files.

Note: After the installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 8.

8 When the upgrade is complete, the Setup Complete window opens. In 
this window you are given the option to upgrade your GIFTS Alta 
database.

Important: If the Setup Complete window with the message prompting you 
to perform the database upgrade does not appear, go to “Step 3: Manually 
Upgrading the GIFTS Alta Database” on page 122 and run the database 
upgrade manually.

If you want to run the database upgrade now, select the Run GIFTS Alta 
Database Upgrade check box and click Finish. 

Tip: The database upgrade can take a significant amount of time to 
complete depending on the current size of your database.
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Important: The database upgrade makes irreversible changes to your 
database. Before proceeding, make sure that you have a current backup 
of your database.

❖ If you have not backed up your current database, or want to perform 
the database upgrade later for any reason, clear the check box and 
click Finish. Use instructions found in “Step 3: Manually Upgrading 
the GIFTS Alta Database” on page 122 to run the upgrade yourself 
after backing up the database.

Once the database upgrade is complete, you can proceed to “Step 4: 
Upgrading Your GIFTS ALTA Workstations” on page 124.
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Step 3: Manually Upgrading the GIFTS 
Alta Database

Important: This upgrade needs to be run only once: If you chose to upgrade 
your database at the end of the preceding section, skip this section and go to 
“Step 4: Upgrading Your GIFTS ALTA Workstations” on page 124.

This step updates the structure of your GIFTS Alta database and performs 
data updates to make your database compatible with GIFTS Alta.

Note: Upgrading the database can take a significant amount of time to 
complete. Please take this into consideration when scheduling your database 
upgrade.

This process must be run on a workstation already configured for GIFTS 
Alta. Either run it from the same workstation you used for “Step 2: 
Upgrading the File Server”, or upgrade a workstation according to the 
instructions in “Step 4: Upgrading Your GIFTS ALTA Workstations” on 
page 124 and use it to run the database upgrade following the directions 
below.

!
Caution: The database upgrade makes irreversible changes to your GIFTS 
Alta database. Before proceeding, make sure that you have a current backup 
of your database.

To upgrade your GIFTS Alta database:

1 At the workstation you upgraded in Step 3, open the Windows Start menu 
and select Run.

2 Browse to locate the GIFTS Alta Master/Install folder and double-click 
on the Setup.exe file. This will essentially run through the GIFTS Alta 
install again.

3 When you reach the Setup Complete window, make sure the Run GIFTS 
Alta Database Upgrade check box is selected and and click Finish to run 
the upgrade.
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4 A process log indicates the progress of the upgrade, and a message 

indicates when the upgrade has successfully completed. Click OK to 
continue.

If you receive a message that the upgrade did not complete successfully, 
click Print or Save As to keep the log and fax it to MicroEdge Technical 
Support at (212) 757-1784 or email it to helpdesk@microedge.com.
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Step 4: Upgrading Your GIFTS Alta 
Workstations

The next step is to perform the Workstation Upgrade on your remaining 
workstations. This process updates the system files the workstations need to 
run GIFTS Alta. Clients with Oracle server may also need to update the 
ODBC data source on each workstation.

Running the Workstation Upgrades

The GIFTS Alta Workstation Upgrade must be run on every workstation 
that has access to GIFTS Alta except the workstation used to run the file 
server upgrade. That workstation was updated during the file server 
upgrade process.

Important: The workstation upgrade must be run from a network copy of the 
Setup program.

To upgrade a GIFTS Alta workstation:

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
Alta program icons to be displayed in the Windows Start menu, and click 
Next. The Start Copying Files window opens.

4 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Alta Workstation 
Installation” is to take place in the folder you specified; the following line 
should note that this is an “Upgrade to an existing installation.”

If the options are correct, click Next. The upgrade begins.
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5 If the workstation is not running a compatible version of the Microsoft 

Data Access Components (MDAC) software needed to run GIFTS Alta, 
you are prompted to install it. Click OK and follow the on-screen 
instructions to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the upgrade is complete, you are notified. Click Finish.

7 If you have an Oracle server system, please refer to the procedure in the 
following section, “Updating the Data Source on Oracle Systems”, for 
information about updating the ODBC data source on the workstation.

Repeat this procedure on each GIFTS Alta workstation. Once you have 
upgrade all of your GIFTS Alta workstations, your GIFTS Alta upgrade is 
complete! You may now resume your use of GIFTS Alta.

Important: If you have MyGIFTS or ReviewerCONNECT, you now need to 
upgrade GIFTS Connections. Please refer to the GIFTS Connections: 
MyGIFTS and ReviewerCONNECT Installation and Technical Reference Guide for 
more information.

Updating the Data Source on Oracle Systems

If you have an Oracle server system and are upgrading from GIFTS 6.4 or 
later, or a previous version of Alta—or if you have an Oracle server system 
and did not update the ODBC data source on your GIFTS workstations 
when you upgraded—use the following procedure on each GIFTS 
workstation to update your ODBC data source.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.
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This procedure updates the ODBC data source on the workstation to specify 
the certified Crystal Reports ODBC driver listed in the ‘Compatibility Facts 
Sheet’ for your version of GIFTS Alta. This driver is required by the Crystal 
Reports viewer used in the GIFTS Alta Report Library. GIFTS Alta uses a 
different ODBC driver (as specified in the fact sheet), but uses the 
information in this data source to locate the GIFTS Alta database.

To update the data source for a GIFTS Alta workstation: 

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 Click the System DSN tab. The data sources for the workstation are listed.

3 Highlight the data source currently being used to connect to the GIFTS 
Alta database (the default DSN name is GIFTS), and click Remove. The 
data source is removed.

4 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

5 From the list of ODBC Drivers, choose CR Oracle ODBC Driver 5.0 and 
click Finish. The ODBC Oracle Driver Setup window is displayed.

6 In the Data Source Name field, enter GIFTS (or the DSN that you use for 
your GIFTS database).

7 In the Server Name field, enter the name of the database server you are 
using with GIFTS Alta.

8 Click OK and close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.
126 Step 4: Upgrading Your GIFTS ALTA Workstations



9 Upgrading
GIFTS Alta with Citrix

Presentation Server
This chapter describes how to upgrade GIFTS Alta on computers 
running Windows® Terminal Services and Citrix® Presentation 
Server™.

In This Chapter
Before You Begin..................................................................128

Upgrading a GIFTS Alta Workstation Running Citrix ........131

Upgrading a Standalone System Running Citrix..................134



Upgrading GIFTS Alta with Citrix Presentation Serv-9

Before You Begin

This process upgrades your GIFTS 6.4 or later, or previous version of Alta 
system to the most recent GIFTS Alta.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

The following important points should be addressed before you upgrade 
GIFTS:

❖ Your program, database, reports, and template files are altered by this 
process. Please make a complete backup of your current GIFTS directory 
before proceeding.

❖ All users must be logged out of GIFTS for the duration of the upgrade.

❖ If you are using any virus-protection software, please disable it before you 
upgrade GIFTS. Virus-protection programs may cause errors during the 
upgrade process.

❖ If Business Objects Crystal Reports is installed on your system, be sure to 
read “Compatibility with Crystal Reports” on page 184.

❖ Read the following sections, “Option 1: Citrix Workstation Upgrade” and 
“Options 2: Citrix Standalone Upgrade”, to determine which type of 
upgrade you need to perform. If your configuration is not included among 
these options, please contact MicroEdge Technical Support for advice.

The points above are vital to ensuring that your upgrade is successful. Please 
make sure that each issue has been thoroughly addressed before continuing. 
The options that follow describe the different types of GIFTS Alta 
installations that can be upgraded using the procedures in this chapter.
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Option 1: Citrix Workstation Upgrade

This type of upgrade is for clients who have installed the GIFTS Alta 
workstation software on a computer running Citrix, as described in “Option 
1: Installing a GIFTS Alta Workstation” on page 86. 

In this process, you will upgrade your GIFTS Alta system—and then 
upgrade the workstation that is running Citrix Presentation Server. To 
perform this type of upgrade, please refer to “Upgrading a GIFTS Alta 
Workstation Running Citrix” on page 131.

Options 2: Citrix Standalone Upgrade

This upgrade is for systems where the entire GIFTS Alta system has been 
installed on a single computer running Citrix, as described in “Option 2: 
Installing a Standalone System” on page 90. 

In this process, you will simply upgrade the GIFTS Alta system on that 
computer, as described in “Upgrading a Standalone System Running Citrix” 
on page 134.

Other Upgrade Options

If neither of the two preceding options applies to your GIFTS Alta system, 
please contact MicroEdge Technical Support for advice regarding your 
upgrade of GIFTS with Citrix Presentation Server.

System Files

For a complete list of the system files installed by the GIFTS upgrade, 
consult the “Installation Impact Analysis” on page 175.
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How to Obtain Technical Support

If you have any difficulties during this process, please contact MicroEdge 
Technical Support in one of the following ways:

❖ by submitting an electronic support request. Go to 
http://www.microedge.com/support and log in to the support website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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Upgrading a GIFTS Alta Workstation 
Running Citrix

This procedure describes how to upgrade the GIFTS Alta software on a 
GIFTS Alta workstation running Windows Terminal Services with Citrix 
Presentation Server.

Step 1: Upgrade Your GIFTS Alta System

The first step is to upgrade all parts of your GIFTS Alta system except the 
workstation that you use to provide access through Citrix Presentation 
Server. To upgrade GIFTS Alta, please follow the instructions for your 
system configuration:

❖ Clients with a file server system should refer to the instructions in 
“Upgrading a GIFTS Alta Standalone Workstation or File Server” on 
page 99.

❖ Clients with a Microsoft SQL Server or Oracle server environment should 
follow the instructions in“Upgrading GIFTS Alta Client/Server 
Installations” on page 113.

Note: If you wish to upgrade a standalone GIFTS Alta system, please refer to 
“Upgrading a Standalone System Running Citrix” on page 134.

Step 2: Disabling Remote Logons

Before upgrading GIFTS Alta, you should disable remote logons to your 
Citrix Presentation Server. To do so, please follow the instructions in “Step 
2: Disabling Remote Logons” on page 86. Then, proceed to the next step.

Step 3: Upgrading GIFTS Alta on Your Citrix Server

Before You Begin: Please review the following important information regarding 
the upgrade of GIFTS Alta with Citrix:

❖ You must launch the GIFTS Alta Setup program from within the Add/
Remove Programs Control Panel, as described in this procedure. If you 
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do not run GIFTS Alta Setup from within the Control Panel, GIFTS Alta 
will not run under Terminal Services.

❖ If you are prompted to restart the computer during the upgrade 
procedure, choose to Restart later. You must complete the entire GIFTS 
Alta upgrade process and close the Add/Remove Programs utility before 
restarting the computer.

❖ At the conclusion of the GIFTS Alta Setup process, you should close the 
Add/Remove Programs utility before proceeding; make sure that the 
GIFTS Alta upgrade is complete before closing the utility.

To upgrade GIFTS Alta on your Citrix Presentation Server:

1 From the Windows Start menu of the computer running Citrix, choose 
Control Panel ➤ Install Application from Remote Desktop.

2 Browse to and run the Setup.exe program located in the GIFTS\Setup 
directory of your GIFTS Alta file server.

Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta Setup process begins.

3 You may now upgrade GIFTS Alta, as described in the section that applies 
to your configuration of GIFTS Alta:

Important Reminder: You must run the GIFTS Alta Setup program from within 
the Add/Remove Programs Control Panel.

❖ File server installations – please refer to “Step 4: Upgrading Other 
GIFTS ALTA Workstations” on page 111. 

❖ SQL Server and Oracle installations – please refer to “Step 4: 
Upgrading Your GIFTS ALTA Workstations” on page 124.

When you have finished upgrading the GIFTS Alta workstation software, 
you may proceed to the next step.
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Step 4: Copying the GIFTS Alta Help Files

To make the GIFTS Alta online help available to each user, this procedure 
describes how make the GIFTS Alta help files available to users who access 
GIFTS Alta through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following GIFTS Alta help files:

3 Paste the GIFTS Alta help files to the virtual WINDOWS or WINNT 
directory of each user who uses GIFTS Alta through Citrix. The locations 
of these virtual directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS Alta help files are now available to your users. Please continue to 
the next step to complete your upgrade.

Step 5: Completing Your Upgrade

To complete your upgrade, just re-enable logons to your server. Your 
upgrade of GIFTS Alta with Citrix is complete! 

empadmin.chm gfwbudget.chm

empgifts.chm gfwgam.chm

gfwadmin.chm gifts.chm

gfwap.chm mesupp.chm

altagifts.chm gfw60.chm
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Upgrading a Standalone System Running 
Citrix

This procedure describes how to upgrade a standalone GIFTS Alta system 
on a computer running Citrix Presentation Server. Using this procedure, all 
components of GIFTS Alta will be upgraded—including the GIFTS Alta 
database. This option does not apply to client/server systems.

Step 1: Disabling Remote Logons

Before upgrading GIFTS Alta, you should disable remote logons to your 
Citrix Presentation Server. To do so, please follow the instructions in “Step 
2: Disabling Remote Logons” on page 86. Then, proceed to the next step.

Step 2: Update Your GIFTS Alta Configuration File

If you received a new Configuration file from MicroEdge with your 
upgrade, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
tFile with their upgrade package; most clients do not receive a new Configuration 
File. If you did not receive a Configuration file, please skip to “Step 3: 
Upgrading GIFTS Alta”.

To update your GIFTS Alta configuration file:

1 Copy the gifts.cfg file from your Configuration File to the \GIFTS directory 
on your server. A message warns that you are overwriting an existing file. 
Click Yes to continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.
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Step 3: Upgrading GIFTS Alta

Before You Begin: Please review the following important information regarding 
the upgrade of GIFTS Alta with Citrix:

❖ You must launch the GIFTS Alta Setup program from within the Add/
Remove Programs Control Panel, as described in this procedure. If you 
do not run GIFTS Alta Setup from within the Control Panel, GIFTS Alta 
will not run under Terminal Services.

❖ If you are prompted to restart the computer during the upgrade 
procedure, choose to restart later. You must complete the entire GIFTS 
Alta upgrade process and close the Add/Remove Programs utility before 
restarting the computer.

❖ At the conclusion of the GIFTS Alta Setup process, you should close the 
Add/Remove Programs utility before proceeding; make sure that the 
GIFTS Alta upgrade is complete before closing the utility.

To upgrade a standalone GIFTS Alta system on your Terminal Server:

1 From the Windows Start menu, choose Control Panel ➤ Install 
Application from Remote Desktop.

2 Browse to the location of the GIFTS Alta Upgrade files and run the 
Setup.exe file in the Master/Install.

3 The GIFTS Alta Setup process begins.

Important Reminder: You must run the GIFTS Alta Setup program from within 
the Control Panel.

4 You may now continue with your GIFTS Alta upgrade. To do so, please 
follow the steps in “Step 2: Upgrading Program Files” on page 104.

5 If you did not elect to upgrade your database during the previous step, 
please follow the instructions in “Step 3: Manually Upgrading the 
Database” on page 106 to do so.

When you have finished upgrading GIFTS Alta, you may proceed to the 
next step.
Upgrading a Standalone System Running Citrix 135



Upgrading GIFTS Alta with Citrix Presentation Serv-9

Step 4: Copying the GIFTS Alta Help Files

To make the GIFTS Alta online help available to each user, this procedure 
describes how make the GIFTS Alta help files available to users who access 
GIFTS Alta through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following files:

3 Copy the GIFTS Alta help files to the virtual WINDOWS or WINNT 
directory of each user who uses GIFTS Alta through Citrix. The locations 
of these virtual directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS Alta help files are now available to your users. Please continue to 
the next step to complete your upgrade.

Step 5: Completing Your Upgrade

To complete your upgrade, just re-enable logons to your Presentation 
Server. Your upgrade of GIFTS Alta with Citrix is complete!

empadmin.chm gfwbudget.chm

empgifts.chm gfwgam.chm

gfwadmin.chm gifts.chm

gfwap.chm mesupp.chm
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Before You Begin

This process upgrades your GIFTS 6.4 or later, or previous version of Alta 
system to the most recent GIFTS Alta.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

The following important points should be addressed before you upgrade 
GIFTS Alta:

❖ Your program, database, reports, and template files are altered by this 
process. Please make a complete backup of your current GIFTS Alta 
directory before proceeding.

❖ All users must be logged out of GIFTS Alta for the duration of the upgrade.

❖ If you are using any virus-protection software, please disable it before you 
upgrade GIFTS Alta. Virus-protection programs may cause errors during 
the upgrade process.

❖ Read the following sections, to determine which type of upgrade you need 
to perform. If your configuration is not included among these options, 
please contact MicroEdge Technical Support for advice.

❖ Always upgrade your File server before upgrading your Terminal server.

The points above are vital to ensuring that your upgrade is successful. Please 
make sure that each issue has been thoroughly addressed before continuing. 
The options that follow describe the different types of GIFTS Alta 
installations that can be upgraded using the procedures in this chapter.
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Upgrading GIFTS Alta on a Terminal Server

To upgrade your GIFTS Alta on a Terminal Server, follow the same 
procedure as a new installation.

Refer to “Step 1: Terminal Server Installation” on page 95.

How to Obtain Technical Support

If you have any difficulties during this process, please contact MicroEdge 
Technical Support in one of the following ways:

❖ by submitting an electronic support case. Go to 
http://www.microedge.com and log in to the GIFTS PowerME support 
website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
Before You Begin 139



Upgrading GIFTS Alta on Terminal Server10

Upgrading a GIFTS Alta Workstation 
Running Citrix

This procedure describes how to upgrade the GIFTS Alta software on a 
GIFTS Alta workstation running Windows Terminal Services with Citrix 
Presentation Server.

Step 1: Upgrade Your GIFTS Alta System

The first step is to upgrade all parts of your GIFTS Alta system except the 
workstation that you use to provide access through Citrix Presentation 
Server. To upgrade GIFTS Alta, please follow the instructions for your 
system configuration:

❖ Clients with a file server system should refer to the instructions in 
“Upgrading a GIFTS Alta Standalone Workstation or File Server” on 
page 99.

❖ Clients with a Microsoft SQL Server or Oracle server environment should 
follow the instructions in“Upgrading GIFTS Alta Client/Server 
Installations” on page 113.

Note: If you wish to upgrade a standalone GIFTS Alta system, please refer to 
“Upgrading a Standalone System Running Citrix” on page 143.

Step 2: Disabling Remote Logons

Before upgrading GIFTS Alta, you should disable remote logons to your 
Citrix Presentation Server. To do so, please follow the instructions in “Step 
2: Disabling Remote Logons” on page 86. Then, proceed to the next step.

Step 3: Upgrading GIFTS Alta on Your Citrix Server

Before You Begin: Please review the following important information regarding 
the upgrade of GIFTS Alta with Citrix:

❖ You must launch the GIFTS Alta Setup program from within the Add/
Remove Programs Control Panel, as described in this procedure. If you 
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do not run GIFTS Alta Setup from within the Control Panel, GIFTS Alta 
will not run under Terminal Services.

❖ If you are prompted to restart the computer during the upgrade 
procedure, choose to Restart later. You must complete the entire GIFTS 
Alta upgrade process and close the Add/Remove Programs utility before 
restarting the computer.

❖ At the conclusion of the GIFTS Alta Setup process, you should close the 
Add/Remove Programs utility before proceeding; make sure that the 
GIFTS Alta upgrade is complete before closing the utility.

To upgrade GIFTS Alta on your Citrix Presentation Server:

1 From the Windows Start menu of the computer running Citrix, choose 
Control Panel ➤ Install Application from Remote Desktop.

2 Browse to and run the Setup.exe program located in the GIFTS\Setup 
Alta directory of your GIFTS Alta file server.

Example: If you designated P:\GIFTS as your GIFTS Alta directory, the 
Setup.exe file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Alta Setup process begins.

3 You may now upgrade GIFTS Alta, as described in the section that applies 
to your configuration of GIFTS Alta:

Important Reminder: You must run the GIFTS Alta Setup program from within 
the Add/Remove Programs Control Panel.

❖ File server installations – please refer to “Step 4: Upgrading Other 
GIFTS ALTA Workstations” on page 111. 

❖ SQL Server and Oracle installations – please refer to “Step 4: 
Upgrading Your GIFTS ALTA Workstations” on page 124.

When you have finished upgrading the GIFTS Alta workstation software, 
you may proceed to the next step.
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Step 4: Copying the GIFTS Alta Help Files

To make the GIFTS Alta online help available to each user, this procedure 
describes how make the GIFTS Alta help files available to users who access 
GIFTS Alta through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following GIFTS Alta help files:

3 Paste the GIFTS Alta help files to the virtual WINDOWS or WINNT 
directory of each user who uses GIFTS Alta through Citrix. The locations 
of these virtual directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS Alta help files are now available to your users. Please continue to 
the next step to complete your upgrade.

Step 5: Completing Your Upgrade

To complete your upgrade, just re-enable logons to your server. Your 
upgrade of GIFTS Alta with Citrix is complete! 
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Upgrading a Standalone System Running 
Citrix

This procedure describes how to upgrade a standalone GIFTS Alta system 
on a computer running Citrix Presentation Server. Using this procedure, all 
components of GIFTS Alta will be upgraded—including the GIFTS Alta 
database. This option does not apply to client/server systems.

Step 1: Disabling Remote Logons

Before upgrading GIFTS Alta, you should disable remote logons to your 
Citrix Presentation Server. To do so, please follow the instructions in “Step 
2: Disabling Remote Logons” on page 86. Then, proceed to the next step.

Step 2: Update Your GIFTS Alta Configuration File

If you received a new Configuration file from MicroEdge with your 
upgrade, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS —will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
tFile with their upgrade package; most clients do not receive a new Configuration 
File. If you did not receive a Configuration file, please skip to “Step 3: 
Upgrading GIFTS Alta”.

To update your GIFTS Alta configuration file:

1 Copy the gifts.cfg file from your Configuration File to the \GIFTS directory 
on your server. A message warns that you are overwriting an existing file. 
Click Yes to continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.
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Step 3: Upgrading GIFTS Alta

Before You Begin: Please review the following important information regarding 
the upgrade of GIFTS Alta with Citrix:

❖ You must launch the GIFTS Alta Setup program from within the Add/
Remove Programs Control Panel, as described in this procedure. If you 
do not run GIFTS Alta Setup from within the Control Panel, GIFTS Alta 
will not run under Terminal Services.

❖ If you are prompted to restart the computer during the upgrade 
procedure, choose to restart later. You must complete the entire GIFTS 
Alta upgrade process and close the Add/Remove Programs utility before 
restarting the computer.

❖ At the conclusion of the GIFTS Alta Setup process, you should close the 
Add/Remove Programs utility before proceeding; make sure that the 
GIFTS Alta upgrade is complete before closing the utility.

To upgrade a standalone GIFTS Alta system on your Terminal Server:

1 From the Windows Start menu, choose Control Panel ➤ Install 
Application from Remote Desktop.

2 Browse to the location of the GIFTS Alta Upgrade files and run the Setup 
file. The GIFTS Alta Setup process begins.

Important Reminder: You must run the GIFTS Alta Setup program from within 
the Control Panel.

3 You may now continue with your GIFTS Alta upgrade. To do so, please 
follow the steps in “Step 2: Upgrading Program Files” on page 104.

4 If you did not elect to upgrade your database during the previous step, 
please follow the instructions in “Step 3: Manually Upgrading the 
Database” on page 106 to do so.

When you have finished upgrading GIFTS Alta, you may proceed to the 
next step.
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Step 4: Copying the GIFTS Alta Help Files

To make the GIFTS Alta online help available to each user, this procedure 
describes how make the GIFTS Alta help files available to users who access 
GIFTS Alta through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following files:

3 Copy the GIFTS Alta help files to the virtual WINDOWS or WINNT 
directory of each user who uses GIFTS Alta through Citrix. The locations 
of these virtual directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS Alta help files are now available to your users. Please continue to 
the next step to complete your upgrade.

Step 5: Completing Your Upgrade

To complete your upgrade, just re-enable logons to your Presentation 
Server. Your upgrade of GIFTS Alta with Citrix is complete!

empadmin.chm gfwbudget.chm

empgifts.chm gfwgam.chm

gfwadmin.chm gifts.chm

gfwap.chm mesupp.chm
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11 GIFTS Alta
Extensions: Link and

Reminders Engine
This chapter describes how to install the optional GIFTS Alta 
Extensions for Link and Reminders.
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Installing GIFTS Alta Extensions

GIFTS Alta includes two optional extensions which were once part of the 
GIFTS Plus Pack.

❖ GIFTS Alta Link for Use with Outlook

❖ GIFTS Alta Reminders Engine

GIFTS Alta Link for Use with Outlook

Link allows you to do the following with GIFTS Alta:

❖ Send Outlook email to GIFTS Alta as a Mail Activity and optionally link 
the Mail Activity with a record in GIFTS Alta. 

❖ Store the email and/or email attachments as documents. (Document 
Manager required) 

❖ The body of the email will be saved in the Long Notes section of the Mail 
Activity or the email will be saved as a message (.msg) file in Document 
Manager. 

❖ If configured for it, email attachments may also be exported into GIFTS 
Alta as External Document Activities.

GIFTS Alta Reminders Engine

The Reminders Engine allows you to do the following with GIFTS Alta:

❖ Generate automated reminders

❖ Send reminders to multiple recipients
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Overview of the Setup and Installation 
Process

For installation, you will need to do the following:

1 In the Administrator Module, use the Extended Alta Settings tool to set 
up the security permissions for Reminders and Link Plus.

2 Close both Outlook and GIFTS Alta.

3 Install the Link extension, if desired. 

4 Install the Reminders Engine extension, if desired.

Important: Both Outlook and GIFTS Alta must be closed when you install 
Link.

Step 1: The Extended Alta Settings Tool

Reminders and Link have the ability to affect large amounts of data in a 
single operation. Since these changes cannot be undone, it is important to 
restrict the use of these utilities to qualified members of your staff.

You can use the Alta Extended Settings tool to determine which GIFTS Alta 
users have access to the functions provided by Reminders Plus and Link.

The GIFTS Extended Alta Settings tool can be accessed through the GIFTS 
Administrator Module under Tools > Extended Alta Settings.

For more information, please refer to the section on GIFTS Alta Extended 
Configuration Settings in the GIFTS Alta Administrator's Module User Guide.

Step 2: Installing Link for Use with Outlook

Note: Link is not compatible with 64-bit Outlook.

Link allows you to import Outlook email and email attachments into GIFTS 
Alta as Mail Activities and External Document Activities, respectively.
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Before You Begin: 

❖ Both Outlook and GIFTS Alta must be closed when you install Link. 

❖ If you are re-installing or updating Link for use with Outlook, you must 
first make sure the previous version of Link has been completely 
uninstalled. Please refer to Solution article 1946 in the GIFTS PowerME 
site for details. 

❖ If you are installing Link for the first time, you can simply proceed.

❖ Document Manager: In order to import Outlook email attachments, you 
must have the Document Manager installed.

❖ Install for Everyone Option: This option during the install process allows 
Link Plus to be available to anyone who logs in to the same workstation. 
It is only available to Office 2007 or 2010 users and you must be logged in 
as an Administrator during the installation process.

❖ Office 2003 Users: The install for Everyone option is not available. 

❖ Office 2007 Users: If you wish to use the install for Everyone option, a 
Microsoft Hotfix must first be downloaded and installed. Please refer to 
http://support.microsoft.com/kb/976811.  

❖ All Citrix users: Link will not work with Citrix unless Outlook is also 
accessed via Citrix.

❖ Citrix users with Office 2003: Each Link user must have the Link 
installation run separately under their user login on the Citrix server that 
he or she will be accessing.

To Install Link Plus for Outlook:

1 From your GIFTS Alta workstation browse to the Alta Extensions sub 
folder, typically installed in the GIFTS Alta directory (e.g., C:\GIFTS\Alta 
Extensions), and open the AltaLink Setup folder.

Note: For Citrix users, browse from the Citrix server to the Alta 
Extensions subfolder.
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2 Open the AltaLink subfolder for your version of Outlook and double-click 

Setup.exe.

A message may appear advising you that one or more components must 
be installed. Click Accept or Install, as needed, to continue.

Components may include:

❖ Windows Installer 4.5

❖ Microsoft Visual Studio 20xx Tools for Office Runtime

❖ Microsoft Office 20xx Primary Interop Assemblies

3 Click Install. 

4 When the Link Setup Wizard appears, click Next. 

5 The installer will inform you of the default folder location for the 
installation.

6 If you want to change the default GIFTS Alta Link folder location, click 
Browse and select an alternate folder location. 

You can also click the Disk Cost button to view a list of available drives 
along with their current available space and the required space for the 
initial installation.
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7 Click Next to continue. 

8 When the Confirmation Installation screen appears, click Next.

9 When Link installation is complete, click Close. 

Step 3: Installing the GIFTS Alta Reminders 
Engine

Before You Begin: 

❖ If you are upgrading to the GIFTS Alta Reminders Engine, you must first 
uninstall your older version of the GIFTS Reminders Plus Engine through 
your Start > Control Panel > Add/Remove Programs feature. 

❖ Delete the old shortcut to the Reminders Plus Engine you may have on 
your desktop to manually generate and send reminders.

Note: The normal GIFTS Alta Reminders feature is installed with GIFTS Alta. 

Although you can create reminders from any GIFTS Alta workstation by 
going to User menu > Reminders, you can only manually generate and 
send reminders from a workstation on which you have installed the GIFTS 
Alta Reminders Engine.

To install the Reminders Engine:

1 Go to the Alta Extensions folder, typically installed in the GIFTS Alta 
directory (e.g., C:\GIFTS\Alta Extensions), and open the AltaReminder 
Setup subfolder.

2 Double-click Setup.exe. The Alta Reminders Engine Setup Wizard is 
displayed.

3 Click Next, and then Next again. The Alta Reminders Engine files are 
installed on the workstation. 

4 Click Finish. The Alta Reminders Engine installation is complete.
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Creating a Shortcut to Generate Reminders Manually

The Reminders Engine can be run manually at any time from a workstation 
on which the Reminders Engine Setup has been run.

The Reminders Engine is run via the AltaReminders.exe located in your Alta 
Extensions subfolder. However, because this executable also runs the 
normal GIFTS Alta Reminders feature, if you double-click the 
AltaReminders.exe, it will open the normal Reminders setup feature, exactly 
as if you had selected it from your GIFTS Alta User’s menu. 

In order to tell the AltaReminders.exe to run the Reminders Engine to 
generate and send reminders, you need to add a specific parameter to the 
run command. 

This is done by creating and modifying a shortcut to the AltaReminders.exe.

To create a shortcut to run the Reminders Engine:

1 Locate AltaReminders.exe in your Alta Extensions directory.

2 Right-click on AltaReminders.exe and select Create Shortcut. A shortcut 
is created in the same folder. You can move this shortcut, for example to 
your desktop, after creating it.

3 Right-click on the shortcut and select Rename. Rename your shortcut 
“Reminders Engine”, or something else you will remember easily. You do 
not need to include .exe in the name.

4 Right-click on the shortcut and select Properties. The Properties window 
appears.

5 In the Target field, at the end of the path to AltaReminders.exe, type a 
blank space and then type “-generate” (do not type a blank space after “-
generate”). This parameter indicates that the Reminders Engine should 
run, generating and sending reminders.

6 Click Apply.

Your shortcut is now set up to run the Reminders Plus Engine. You can 
double-click this shortcut to generate and send reminders manually at any 
time. 
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12 Maintenance,
Security, and Data

Integrity
This chapter describes the diagnostic and maintenance utilities 
provided for GIFTS Alta, and the GIFTS Alta security features. It also 
describes the products used to develop the GIFTS Alta software.

In This Chapter
GIFTS Alta Diagnostics Utility.............................................156

Isolating System File Conflicts .............................................157

Maintaining Your Database..................................................158

Budget Diagnostics Utility....................................................160

Security and Data Integrity ..................................................161

System Architecture .............................................................163



Maintenance, Security, and Data Integrity12

GIFTS Alta Diagnostics Utility 

The GIFTS Alta Diagnostics utility is designed to assist MicroEdge’s 
Technical Support staff in identifying and resolving problems in your GIFTS 
Alta installation. By using these diagnostic tools, you can provide most of 
the information Technical Support needs to assist you, without the need to 
involve additional technical staff or consultants. 

The utility includes the following features:

❖ System Information: indicates the type of database used by your 
installation of GIFTS Alta, and provides a summary of system information 
like memory, available resources, and the current Windows Regional 
Settings.

❖ GIFTS Alta Information: a summary of all of the GIFTS Alta-related files, 
used to identify problematic versions or duplicate files. This can be used 
to list the system files installed with GIFTS Alta, or to find specific files.

❖ List System Files: displays the contents of files that store system 
information, including the AUTOEXEC.BAT, CONFIG.SYS, gifts.ini, and 
GIFTS.SYS files.

❖ Database Test: used to verify that the workstation’s connection to the 
database is valid.

❖ Budget Verifier: used to verify data used by the optional Budget Module.

❖ Template Creation Test and Merge Letter Test: used to test the ability 
of GIFTS Alta to created merged correspondence with Microsoft Word.

❖ IGAM Application Retrieval Test: used to verify that the optional 
Internet Grant Application Module can connect to the IGAM server and 
retrieve online applications.

To access this utility:

1 Log in to any GIFTS Alta application.

2 From the Main menu, select User menu ➤ About Alta.

3 Click the System Info button.
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Isolating System File Conflicts

You can use Microsoft’s MSINFO utility to isolate the system files (such as 
DLLs and OCX files) that are running when errors occur. It also facilitates 
troubleshooting by identifying the different sets of files that are installed and 
running on workstations that either do, or do not, have problems.
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Maintaining Your Database

The following sections describe the utilities and procedures available for 
maintaining your GIFTS Alta database. Note that some responsibilities for 
maintaining your database depend on whether your system uses a Microsoft 
Access database or a client/server (Microsoft SQL Server or Oracle server) 
database.

File Server Database Maintenance

MicroEdge provides a Database Maintenance Tool for the maintenance and 
correction of the Microsoft Access database used by standalone installations 
of GIFTS Alta and the file server version of GIFTS Alta.

!
Caution: The MicroEdge Database Maintenance Tool should be used only 
under the direction of MicroEdge Technical Support personnel.

This tool includes the following functions:

❖ Repair/Compact: used to repair a corrupted database, and rearranges and 
minimizes the information to reduce fragmentation. The database may 
become corrupted if GIFTS Alta quits unexpectedly (for example, if there 
is a power outage or a hardware malfunction). Most often, GIFTS Alta 
detects and reports database corruption problems. However, MicroEdge 
Technical Support may recommend that you run this option to eliminate 
corruption as a cause for certain unexplained errors.

❖ Copy into New Database Container: MicroEdge Technical Support may 
recommend this option if you find the need to repair the database at 
frequent intervals and there is no apparent cause for corruption.

❖ Zip Database: compresses your GIFTS Alta database in a Zip format that 
you can then provide to MicroEdge Technical Support for research 
purposes.

GIFTS Alta users can use a task scheduler to regularly compact and repair 
their database.
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Client/Server Database Maintenance

Users of all client/server systems (Microsoft SQL Server and Oracle) are 
responsible for regular maintenance and performance tuning of the GIFTS 
Alta grants database. MicroEdge recommends the use of the latest versions 
of manufacturer-provided utility programs for this purpose. 

This routine database maintenance should be performed by a trained 
Database Administrator (DBA) in accordance with the client/server 
database manufacturer’s recommendations.

Important: Please make sure that your DBA is trained as a Microsoft SQL 
Server or Oracle Server Administrator, and is familiar with all aspects of 
setting up and administering the SQL Server or Oracle server environment. 
MicroEdge Technical Support personnel cannot provide advice or assistance 
related to the setup of your SQL Server or Oracle server software and/or 
hardware.

Recalculating Summary Data

GIFTS Alta maintains summary data—such as the balance of a grant or the 
total number of payments for a grant—to maximize the speed of queries and 
reports. Occasionally, as users work in GIFTS Alta, this data is not properly 
synchronized. This can happen for a variety of reasons, including network 
communication errors and hardware problems.

If you suspect that the calculations of summary data and totals in GIFTS 
Alta are not synchronized, MicroEdge Technical Support may recommend 
that you use the Recalculate Utility to synchronize your data.

Consolidating Duplicate Records

Data entry errors can result in there being duplicate Organization or 
Contact records in your database. Using the GIFTS Alta Administrator 
Module, you can identify duplicate records and consolidate the links to the 
Requests and Contacts associated with the duplicates into one record. Please 
refer to the GIFTS Alta Administrator’s Guide for more information.
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Budget Diagnostics Utility

The Budget Module Diagnostics Utility helps MicroEdge Technical Support 
locate any problems you may encounter with data for the optional Budget 
Module. 
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Security and Data Integrity

This section discusses the security and integrity of your data in the GIFTS 
Alta environment. GIFTS Connections administrators face additional data 
security considerations, especially if they have MyGIFTS and/or 
ReviewerCONNECT users accessing GIFTS Alta data over the Internet. For 
information about GIFTS Connections data security considerations, please 
refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation 
and Technical Reference Guide.

Security Levels

GIFTS Alta has advanced security features that allow multi-level program 
access based on the rights assigned to an individual or a specified group of 
users. This security is established and maintained by the GIFTS Alta 
Administrator.

Password Security

GIFTS Alta provides for the creation and maintenance of unique User IDs 
and passwords. GIFTS Alta also supports Windows NT integrated security, 
which permits grantmakers who use Windows servers to skip the GIFTS 
Alta login process: each user’s Windows login ID is automatically read and 
used by GIFTS Alta. Similar login integration is provided for Microsoft SQL 
Server and Oracle databases. For more information, please refer to the 
GIFTS Alta Administrator’s Guide.

Rollback Recovery

GIFTS Alta offers the highest level of reliability and data-integrity possible in 
both its file server and client/server configurations by utilizing engine-level 
“transaction commit and rollback” technology. This means that if your 
computer is halted in the middle of a GIFTS Alta fund transfer between two 
budget categories, there is no data corruption since GIFTS Alta only commits 
the changes once the entire transaction is completed successfully.
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Audit Trail

GIFTS Alta maintains a log of the last date of user input for all database 
records, as well as a detailed record of all critical system transactions by user, 
date, and time.

File Server Access Rights

GIFTS Alta requires that all users have full access rights to the network 
directory and subdirectories where GIFTS Alta is installed.

Client/Server Access Security

GIFTS Alta provides its own internal login security, and does not handle 
security for Microsoft SQL Server and/or Oracle server. While both SQL 
and Oracle have complex security features, GIFTS Alta does not interact 
with them. The GIFTS Alta login used for SQL or Oracle must be the 
“owner” of the database or tables, and therefore has all of the permissions of 
an “owner.”

Database Backup and Recovery

It is the client’s responsibility to conduct nightly verified backups of all 
system data, to rotate media appropriately, and to replace tapes on the 
schedule that is recommended by the manufacturer. We also recommend 
that this essential data be stored both on and off site in secure fireproof and 
waterproof media safes. 

For detailed information about backing up your GIFTS Alta system, please 
search for “backups” in the MicroEdge Solutions Knowledgebase.
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System Architecture

GIFTS Alta has been designed following the principles specified in the 
Microsoft Windows Interface Application Design Guide and the Microsoft 
Windows Software Development Kit.

GIFTS Alta uses a Microsoft Access 2003 database for the standalone and file 
server editions. This database is stored in a standard .MDB file that can be 
read using the Microsoft Access 2003 application.

!
Caution: Never open the production copy of your database with Microsoft 
Access. If an experienced Access user wants to run queries or use other 
Access functions to analyze your data, create a copy of your database for 
these purposes. As described in the Client Resource Guide, MicroEdge will not 
support your GIFTS Alta software if data is entered or modified through any 
means except the application software provided by MicroEdge.

For the client/server editions, the database is either a Microsoft SQL Server 
or Oracle server database that adheres to industry standards and an open 
architecture. All GIFTS Alta databases are compatible with the versions of 
Business Objects Crystal Reports listed in the GIFTS Alta Compatibility 
Facts Sheet. (The Professional edition of Crystal Reports is required for 
client/server systems.)

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet 
on the GIFTS PowerME site for comprehensive compatibility 
information. Search for ‘Compatibility Facts Sheet’ and select the latest 
document for your version of GIFTS Alta.

Note that all editions of GIFTS Alta provide the same user interface and 
functionality regardless of the database used. GIFTS Alta makes extensive 
use of OLE and DDE links to launch compatible word processing and 
spreadsheet applications. It also adheres to the MAPI, VIM, and SMTP/POP 
standards for its links to compatible email packages. 
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13 Expanding
Your GIFTS Alta

System
This chapter describes how you can expand the functionality of 
GIFTS Alta with optional modules, customizations, trade-ups, 
migration, or by linking GIFTS Alta to an external system.
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Optional Modules and Components

The following optional modules and add-ons can be used with any GIFTS 
Alta installation.

Internet Grant Application Manager

The Internet Grant Application Manager (IGAM) enables GIFTS Alta to 
receive grant applications and requirements through the Internet. Incoming 
applications are stored separately from the main GIFTS Alta database, and 
applications can be rejected or transferred to GIFTS Alta for further review. 
After retrieval, requirements directly update GIFTS Alta records. IGAM also 
includes a Forms Manager and Internet Hosting Service that you can use to 
create, post, and manage application and requirement forms.

Employee GIFTS

Employee GIFTS can be used to administer matching gifts and volunteer 
gifts programs:

❖ Matching GIFTS streamlines the management and administration of 
corporate matching gifts programs. You can reduce the amount of time 
you spend entering match requests, checking eligibility, and making 
payments.

❖ Volunteer GIFTS streamlines the management and administration of gifts 
given for your employees’ volunteer projects.

Information about your gifts, payments, and employee donors is integrated 
into the main GIFTS system and becomes part of your overall grants-
tracking data.

Check Writer

You can use the GIFTS Alta Check Writer to print checks directly from 
GIFTS. The Check Writer prints GIFTS Alta data—such as the grantee 
Organization Name, Project Title, and Payment Amount—on your checks 
and maintains a detailed check register for each bank account from which 
you draw funds.
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Accounts Payable Links

You can use A/P links to generate export files that contain your payment 
data. These files can be imported into your accounting software, which is 
used to generate invoices and checks. After your checks have been cut, you 
can import your check data back to GIFTS Alta.

Specific links are available for many popular accounting packages, including 
Blackbaud Accounts Payable, Quicken®, and QuickBooks®.

Reviewers Module

The GIFTS Alta Reviewers Module allows you to schedule reviews, gather 
feedback, interact with reviewers, and make decisions on proposals. You can 
use it to process review packets for external reviewers, or to set up an 
internal review process among your staff members. If you would like your 
reviewers to have access to the system through the Internet, please refer to 
“ReviewerCONNECT” on page 169 for more information.

GIFTS Alta Customizer

The GIFTS Alta Customizer enables you to design additional data entry tabs 
for GIFTS Alta records. In these additional tabs you can display fields 
containing information that is unique to your organization. The custom 
data entry fields can contain text, numeric, currency, date, or coded values—
as well as data calculated from other fields in your system, or even live web 
content.

These custom tabs can be added to Organizations, Contacts, Activities, 
Affiliations, Requirements, Payments, and Requests—in fact, you can set up 
a different custom tab for each Request Type. If you use the optional 
Reviewers Module, you can also customize Review records.

GIFTS Alta Blueprint Module

GIFTS Alta Blueprint is a comprehensive set of tools which have been built 
using the new GIFTS Alta interface to help create custom fields, forms, 
workflows, and keep track of upcoming tasks.
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Note: Once Blueprint is installed, the GIFTS Alta Customizer options will no 
longer be available in the Administrator's module.

The Blueprint tools include:

❖ The Custom Fields Manager

❖ The Fields Library

❖ The Forms Library

❖ The Workflow Library

❖ The Taskboard

❖ The GCS Layouts Manager

Branch Security

Branch Security is an option that allows grant makers with multiple sites or 
branches and separate giving programs to capture all of their information in 
a centralized database, while preventing users from different branches from 
editing (or viewing, if desired) each other’s data. This security is established 
and maintained from within the GIFTS Alta Administrator Module.

Budget Module 

The Budget Module provides up-to-the-minute financial information about 
budgeted, committed, and paid funds, as well as current budget balances.

Import Module

The standard GIFTS Alta product includes a Matching Gifts Summary 
import, and Employee GIFTS Alta includes a Donor import. If these 
imports do not meet your needs, the Import Module expands your options 
for importing data from external systems into GIFTS Alta. This module 
includes Detailed Request, Detailed Matching Gifts, Organization, Contact, 
and Grant Summary imports.
168 Optional Modules and Components



Expanding Your GIFTS Alta System 13

GIFTS Connections

GIFTS Connections makes it possible to access and edit data in your GIFTS 
Alta database through a web browser. The GIFTS Connections Server (GCS) 
retrieves data from your GIFTS Alta database and formats it using HTML 
for display in a web page.

In turn, GCS can also receive data from users connecting through the web 
interface and save it to GIFTS Alta. This allows users the flexibility to 
connect to your GIFTS Alta system from anywhere while your organization 
maintains a single database.

The GIFTS Connections Server is the hub of the GIFTS Connections suite 
of products. With the server translating data to browser-ready form—and 
back again—GIFTS Connections modules designed for specific audiences 
are ready to be added. Two modules have so far been released:

MyGIFTS

MyGIFTS is designed to give members and employees of your organization 
convenient and versatile access to your GIFTS Alta database from remote 
locations. Whether connecting through an intranet or over the Internet, 
your users have a way to interact with GIFTS Alta through their web 
browsers.

MyGIFTS administrators can customize user access and permissions, 
making MyGIFTS a perfect tool for program officers, executives, and casual 
users who need limited, easy-to-use access to GIFTS Alta.

ReviewerCONNECT

If you have the GIFTS Alta Reviewers Module, ReviewerCONNECT gives 
your proposal reviewers convenient and versatile access to your proposals 
from remote locations. Whether connecting through an intranet or over the 
Internet, your reviewers have a way to access, edit, and submit reviews 
through their web browsers.
GIFTS Connections 169



Expanding Your GIFTS Alta System13

System Trade-up and Migration

Trading Up from Standalone to File Server

To upgrade a standalone GIFTS Alta system to a network file server version, 
you can obtain a new configuration file from MicroEdge and then re-install 
GIFTS Alta with the new configuration. All existing grant data, codes, 
document templates, and reports continue operate as before. No database 
conversion is required.

Trading Up to Microsoft SQL Server or Oracle 
Server

The following points describe how clients can upgrade from a standalone or 
file server version of GIFTS Alta (that uses a Microsoft Access database) to a 
client/server system.

Important: When upgrading from an Access system to either Microsoft SQL 
Server or Oracle server, there may be a significant impact on modified 
standard reports and custom reports. Consider this very carefully before 
upgrading.

❖ Database Conversion: When you purchase a client/server license from 
MicroEdge, you’ll receive a reconfiguration package that includes a utility 
you can use to copy your data from the Access database to the SQL or 
Oracle database.

❖ Impact on Standard Reports: All Access-compatible standard reports are 
replaced by client/server-compatible reports during the reconfiguration 
process. No standard reports are lost; however, since all reports are 
overwritten, any changes that have been made to the standard reports are 
lost.

❖ Impact on Custom Reports: SAP Crystal Reports allows you to change 
the database type for your report. Although this feature can be used to 
convert your reports, it is an advanced feature and is not supported by 
MicroEdge Technical Support. If you need assistance with this process, 
please refer to the documentation for your version of Crystal Reports.
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Custom reports created for Microsoft Access systems by MicroEdge are 
not compatible with the client/server systems, and will have to be re-
created. This is a billable service, and the conversion of any critical 
reports should be scheduled well in advance of the “live” date.

❖ Impact on the Crystal Reports: If you use Crystal Reports on any 
computer that is also running GIFTS Alta, please note that for client/
server systems you must use the Professional version of Crystal Reports.

Migrating Server or Server Operating System

Upon installation, GIFTS Alta creates configuration files that store the 
location of the GIFTS Alta programs, data, and document templates. When 
you migrate your GIFTS Alta system to another file server, or if you 
upgrade the operating system on your file server, you should ensure that 
these components can be found by GIFTS Alta. For more information about 
migrating GIFTS Alta to a new file server, please contact MicroEdge 
Technical Support.

Important: When migrating to another server or when upgrading to a new 
server operating system, be sure to map the upgraded system’s drive to the 
same drive letter used by the previous system.

If you use the optional GIFTS Alta Document Manager and change the 
directory name or mapped drive letter that externally attached documents 
are stored in, their links to GIFTS Alta must be updated to reflect the new 
drive mapping.
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Links to External Systems

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet on 
the GIFTS PowerME site for comprehensive compatibility information. 
Search for ‘Compatibility Facts Sheet’ and select the latest document for your 
version of GIFTS Alta.

Commercial Accounting Systems

The GIFTS Alta A/P Module provides built-in links to many popular 
commercial accounting and check writing programs by exporting and 
importing data using ASCII files suitable for use with the supported 
accounting systems. In addition, there is a link with BlackBaud’s Accounts 
Payable.

Custom Accounting Systems

MicroEdge offers clients the capability to contract with MicroEdge for the 
development of a custom export from GIFTS Alta to any in-house or new 
commercial accounting package. The link will create an ASCII file that 
contains the data that you wish to import into the accounting system. Please 
contact your MicroEdge representative for information about these services. 

Note: MicroEdge Product Specialists can help you define the data elements to 
be exported from and imported into GIFTS Alta. We recommend that you 
consider budgeting for this service.

You may also choose to arrange for the development of an export link from 
your accounting system to GIFTS Alta in order to automate the entry of the 
Check Number and Check Date generated by your accounting system. It is 
the client’s responsibility to contract with the developer of the accounting 
system or a skilled programmer to develop and document this export link in 
accordance with MicroEdge’s published import specifications. MicroEdge 
does not provide this service.

In some cases, custom accounting links must be reviewed and updated when 
you upgrade your accounting software. If this needs to be done, MicroEdge 
can provided these consulting services for a fee.
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Exporting Data

Users can export data from GIFTS Alta to Microsoft Excel or an HTML file. 
In addition, the report viewers used by GIFTS Alta for ad hoc reports, 
standard reports, and custom reports enable you to export data to the data 
formats listed in the GIFTS Alta Compatibility Facts Sheet on the GIFTS 
PowerME website.

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet on 
the GIFTS PowerME site for comprehensive compatibility information. 
Search for ‘Compatibility Facts Sheet’ and select the latest document for your 
version of GIFTS Alta.

As with any type of export, some formatting may be lost during the export 
process. 

Linking to Other Products

All versions of GIFTS Alta can be linked in read-only mode to other third party 
products. Clients are responsible for the development, testing, 
documentation, and ongoing support of such links. Clients are also 
responsible for updating such links if MicroEdge modifies database 
structures in future releases of GIFTS Alta.

!
Caution: When linking to other systems, ensure that GIFTS Alta data is not 
modified by any application other than GIFTS Alta. The GIFTS Alta 
database can be corrupted if another application modifies it. As described in 
the Client Resource Guide, MicroEdge will not support your GIFTS Alta 
software if data is entered or modified through any means except the 
application software provided by MicroEdge.
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14 Installation
Impact Analysis

The following impact analyses detail the system files that are installed 
with GIFTS Alta. Files are listed according to the directory where 
they will be installed. 

Note: The GIFTS Alta Setup process overwrites existing system files 
only when the file to be installed is dated later than the existing file. 

In This Chapter
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GIFTS Alta Impact Analysis

The following tables detail the system files that are installed with GIFTS 
Alta. The files are listed according to the directory where they will be 
installed. If no version number is listed for a file, its manufacturer did not 
assign a version number to it.

In cases where the directories differ for computers running different versions 
of Windows, the appropriate directories for each version are noted.

Windows Directory – GIFTS Alta Workstations

This file is installed to the \Windows directory on Windows workstations.

System32 or Syswow64 Directories – GIFTS Alta 
Workstations

On 32-bit Windows workstations, the following files are installed to the 
\Windows\System32 directory.

On 64-bit Windows workstations, the following files are installed to the 
\Windows\Syswow64 directory.

Self-Registering Files

Filename Version File Date Size (in Kb)

GiftsCst.DCT 6/14/2000 1

Filename Version File Date Size (in Kb)

AniGIFV6.ocx 2.0.0.19 4/3/2002 36

arpro2.dll 2.3.1.1264 1/21/2005 1,793

ARVIEW2.OCX 2.3.1.1264 1/21/2005 599

Atl.dll 6.05.2284 7/17/2009 69

c1sizer.ocx 8.0.20071.39 10/2/2006 344

Cfx4032.ocx 4.0 2/1/2001 557

COMCAT.DLL 6.1.7600.16385 7/13/2009 7

Comctl32.ocx 6.00.8105 5/22/2000 595

Comdlg32.ocx 6.00.8418 5/7/1999 137

DSSOCK32.OCX 1.65.000 2/17/1996 48
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dzocx32.ocx 1.0.0.5 11/18/1996 72

exclexpt.dll 2.3.1.1264 1/21/2005 350

htmlexpt.dll 2.3.1.1264 1/21/2005 542

https62.ocx 6.2.0.3071 5/29/2008 214

IGToolBars50.ocx 5.0.0000 3/6/2002 482

ipdaems62.ocx 6.2.0.3071 5/29/2008 166

ipports62.ocx 6.2.0.3071 5/29/2008 162

MEDate.ocx 1.0.0.0 9/30/2004 120

meEmail.dll 1.05.0001 5/29/2013 120

MEGiftsBusiness.dll 1.05.0010 6/6/2013 14937

mem32x30.ocx 3.0.39 6/9/2009 326

METCPCommunica
tions.dll

1.0.0.0 10/18/2002 184

METimer.dll 1.0.0.0 10/18/2002 28

MFC40.DLL 4.1.000 9/18/2010 932

MFC42.DLL 6.06.400 3/11/2011 1111

Mmail32.ocx 5.10.007 2/2/2000 99

MSADODC.OCX 6.0.8804 5/21/2000 117

MSBIND.DLL 6.00.8862 7/14/2000 76

mscomctl.ocx 6.01.9834 6/6/2012 1,046

mshtml.dll 9.00.8112.16450 8/24/2012 12031

msoutl32.ocx 1.0.2922 10/6/1999 77

msscript.ocx 1.0.7600.16385 7/13/2009 93

MSVBVM50.DLL 5.02.8244 (SP2) 12/6/1999 1,324

MSVBVM60.DLL 6.0.9815 7/14/2009 1,354

MSWINSCK.OCX 6.0.8988 12/6/2000 107

NPO_IGAM_Comp
onent.ocx

1.00 2/5/2010 832

OC30.DLL 3.20 5/22/1995 626

oleaut32.dll 6.1.7601.17676 8/27/2011 559

OLEPRO32.DLL 6.1.7601.17514 11/20/2010 88

OUTSIDEX.OCX 7.7.0 5/22/2003 200

pdfexpt.dll 2.3.1.1264 1/21/2005 366

Richtx32.ocx 6.00.8804 5/22/2000 200

rtfexpt.dll 2.3.1.1264 1/21/2005 206

scrrun.dll 5.8.7600.16385 7/13/2009 160

SfxBar.dll 1.0 1/19/2001 127

Filename Version File Date Size (in Kb)
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Other Files

shdocvw.dll 6.1.7601.17514 11/20/2010 176

smtps62.ocx 6.2.0.3071 5/29/2008 189

soaps62.ocx 6.2.0.3071 5/29/2008 242

Spell8.ocx 8.0.20071.65 10/2/2006 291

ssdw3bo.ocx 3.0.000 3/19/2001 865

SSLstBar.ocx 1.0.0000 3/29/1999 253

ssmedt32.dll 1.0.0.38 10/26/1998 71

ssprn32.dll 1.0.0.34 5/6/1998 71

ssr2c.dll 1.0.2.14 3/8/2001 96

Tab32x30 3.1.00 5/30/2000 430

textexpt.dll 2.3.1.1264 1/21/2005 126

THREED20.OCX 2.0.0000 7/1/1997 324

tidate8.ocx 8.0.20071.24 12/20/2006 369

tiffexpt.dll 2.3.1.1264 1/21/2005 254

tishare8.dll 8.0.20071.24 12/20/2006 131

titime8.ocx 8.0.20071.24 12/20/2006 344

TList7.ocx 7.52 12/29/2004 905

Vsflex8.ocx 8.0.20071.237 12/19/2006 631

vsprint8.ocx 8.0.20071.130 12/5/2006 459

vsvport8.ocx 8.0.20071.130 12/5/2006 233

webupls62.ocx 6.2.0.3071 5/29/2008 239

XceedSco.dll 1.0.80 6/26/2001 241

XceedZip.dll 4.2.20.61 1/9/2001 316

Filename Version File Date Size (in Kb)

apigid32.dll 4.0.0.0 10/6/1999 111

ASYCFILT.DLL 6.1.7601.17514 11/20/2010 66

comctl32.dll 6.1.7601.17514 11/20/2010 518

compobj.dll 2.1 6/10/2009 28

CTL3D32.DLL 2.31.0.0 7/13/2009 27

dzip32.dll 3.0.0.15 4/14/1997 122

Edt32x30.ocx 3.0.0.38 9/4/2007 1334

GAPI32.DLL 5.5 12/1/1999 96

gdiplus.dll 6.1.7601.17825 5/4/2004 1607

IMM32.DLL 6.1.7601.17514 11/20/2010 116

Filename Version File Date Size (in Kb)
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Outside-In Viewer Files

This feature is no longer used in GIFTS Alta.  

Instead, the standard Windows behavior of opening the file in the 
application associated with it by Windows is used, including the standard 
Windows prompt to associate the file type with an application if none can be 
found. 

MFCANS32.DLL 2.2.000 10/6/1999 131

mshtml.tlb 8/24/2012 2327

Msldbusr.dll 1.100.1113 11/9/1998 19

msvcirt.dll 6.1.7600.16385 7/13/2009 59

msvcp60.dll 7.0.7600.16385 7/13/2009 397

msvcrt.dll 7.0.7601.17744 12/16/2011 675

msvcrt20.dll 2.12.0.0 8/23.2001 248

msvcrt40.dll 6.1.7600.16385 7/13/2009 60

ole2.dll 2.10 6/10/2009 42

ole2disp.dll 2.10 6/10/2009 166

ole2nls.dll 2.10 6/10/2009 150

OLEDLG.DLL 6.1.7600.16385 7/13/2009 101

RICHED20.DLL 3.1 11/20/2010 463

RICHED32.DLL 6.1.7601.17514 11/20/2010 9

shlwapi.dll 6.1.7601.17514 11./20/2010 342

ssdw3b32.ocx 3.0.00 3/19/2001 865

STDOLE2.TLB 7/13/2009 17

storage.dll 2.10 8/23/2001 5

tibase8.dll 8.0.20071.24 12/20/2006 536

typelib.dll 2.10 6/10/2009 174

usp10.dll 1.0626.7601.715
14

11/20/2010 612

VBAMAP32.DLL 2.1.0.0 8/11/1995 15

winsock.dll 3.10 7/13/2009 3

Filename Version File Date Size (in Kb)
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Crystal Reports Files – GIFTS Alta Workstations

The self-registering Crystal files listed below are installed to the following 
directories on each workstation: 

C:\Program Files\Common Files\Business Objects\3.0\bin.

C:\Program Files\Common Files\Business 
Objects\3.0\crystalreportviewers11\ActiveXControls

Other Crystal files are installed here: C:\Windows\Crystal.

Filename Version File Date Size (in Kb)

craxdrt.dll 11.0.0.2381 2/8/2007 8021

Filename Version File Date Size (in Kb)

crviewer.dll 11.0.0.2385 2/12/2007 13007

Filename Version File Date Size (in Kb)

U2fdif.dll 8.0.1.0 12/07/1999 36

U2fhtml.dll 8.0.1.0 01/06/2000 32

U2frtf.dll 8.0.1.0 01/26/2000 120

U2fwks.dll 8.0.1.0 12/07/1999 40

U2fwordw.dll 8.0.1.0 12/07/1999 104

U2fxls.dll 8.0.1.0 01/26/2000 204

u2lsamp1.dll 8.0.1.0 12/07/1999 24

U2LSTR.DLL 09/06/1995 33

U2LSTRNG.DLL 11/06/1995 27

u2ltec1.dll 09/06/1995 28

u25total.dll 03/31/1998 59
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15 Custom
Reports

This chapter applies only to users who use or intend to use Business 
Objects® Crystal Reports or another third-party report writer to 
create custom reports for GIFTS Alta. If you do not intend to use 
Crystal Reports or another report writer, you may ignore this 
chapter.

In This Chapter
Creating Custom Reports.....................................................182

How GIFTS ALTA Upgrades Affect Custom Reports ..........183

Compatibility with Crystal Reports .....................................184

Upgrades to Crystal Reports ................................................186
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Creating Custom Reports

To meet your reporting needs, the GIFTS Alta Report Library includes more 
than 300 standard reports. For a complete list of these reports, please refer to 
Using GIFTS Alta Reports. 

You can also generate ad hoc reports from the GIFTS Alta Workspace, as 
described in the GIFTS Alta User’s Guide. The ad hoc reporting feature 
includes enhanced options for formatting, sorting, and grouping data in 
reports—as well as an expanded scope of fields that you can report on.

If you need additional reports, you can use any third party report designer 
package to create GIFTS Alta reports. MicroEdge can support your use of 
these products by providing detailed documentation of the GIFTS Alta 
database structures and by answering questions related to that document.

MicroEdge also offers a fee-based service to develop custom reports and to 
upgrade client-modified reports. You should schedule the creation or 
conversion of any critical reports well in advance of the “live” date. For 
detailed information about our support policies and programming services, 
please refer to the Client Resource Guide.

Note: If you want to modify the standard reports provided in the GIFTS Alta 
Report Library, you must use Crystal Reports. Please refer to “Compatibility 
with Crystal Reports” on page 184 for compatibility information.
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How GIFTS Alta Upgrades Affect Custom 
Reports

When you upgrade any GIFTS Alta product, there is the potential for 
incompatibilities with custom reports and/or standard reports that have 
been modified by Crystal Reports.

Impact on All Custom Reports

Changes to the functionality and database structure of GIFTS Alta may 
necessitate changes to your custom reports. To determine whether database 
changes to GIFTS Alta will impact your custom reports, review the Database 
Schema document for the version of GIFTS Alta to which you plan to 
upgrade.

Note: The Database Schema is currently not available in electronic format. 
Please contact MicroEdge Technical Support to request this document.

Impact on Crystal Reports Users

The version of Crystal Reports you are using must always be supported by 
your GIFTS Alta installation. GIFTS Alta is compatible with the versions of 
Crystal Reports listed in the GIFTS Alta Compatibility Facts Sheet. Be sure 
to choose the appropriate version of Crystal Reports when you upgrade 
GIFTS Alta.

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet on 
the GIFTS PowerME site for comprehensive compatibility information. 
Search for ‘Compatibility Facts Sheet’ and select the latest document for your 
version of GIFTS Alta.

New versions of GIFTS Alta often include new standard reports or updates 
to existing standard reports. If you have modified standard reports, ensure 
that the modified version does not have the same filename as the original 
template. If you do not use a new filename, the installation process may 
overwrite your custom report as it updates your standard reports.
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Compatibility with Crystal Reports

This section applies to clients who either:

❖ Plan to install both Crystal Reports and GIFTS Alta on the same 
workstation

❖ Plan to use Crystal Reports to create or modify reports

All other clients can skip this section.

The GIFTS Alta installation process installs Crystal Reports viewer to run 
many of the standard reports in the GIFTS Alta Report Library. Due to the 
presence of this viewer, GIFTS Alta is not compatible with versions of 
Crystal Reports that are not listed on the GIFTS Alta Compatibility Facts 
Sheet by going to the GIFTS PowerME website.

Note: Please refer to the most recent GIFTS Alta Compatibility Facts Sheet on 
the GIFTS PowerME site for comprehensive compatibility information. 
Search for ‘Compatibility Facts Sheet’ and select the latest document for your 
version of GIFTS Alta.

!
Caution: The presence of an incompatible version of Crystal Reports on a 
GIFTS Alta workstation will interfere with the proper performance of both 
GIFTS Alta and Crystal Reports.

MicroEdge recommends the Standard Edition of Crystal Reports for use 
with standalone and file server versions of GIFTS Alta. The Professional 
Edition is required for clients using the client/server version of GIFTS Alta.

When a new version of Crystal Reports becomes available, MicroEdge 
schedules a thorough quality assurance testing cycle to ensure that GIFTS 
Alta and the GIFTS Alta standard reports are compatible with the new 
version. 

In some cases, the upgrade requires adjustments to the standard reports; in 
addition, technical problems may be identified, researched, and resolved in 
coordination with Business Objects.
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Note that there is often a reasonable delay between the release of a Crystal 
Reports upgrade and its certification by MicroEdge. This is the time needed 
to complete quality assurance testing with the standalone, file server, 
Microsoft SQL Server, and Oracle server versions of GIFTS Alta.
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Upgrades to Crystal Reports

This section applies to clients who use Crystal Reports to create or modify 
reports, and who wish to upgrade their Crystal Reports software to a newer 
version. All other clients can skip this section.

When you upgrade Crystal Reports, there is the potential for 
incompatibilities with your custom reports and standard reports that you 
have modified. Reports may have formatting problems, calculation errors, 
or other problems.

Important: Be sure to thoroughly review the GIFTS Alta Compatibility Facts 
Sheet for your version of GIFTS Alta, and the information in this section, to 
determine the impact on your operation before upgrading. Do not upgrade 
to a new version of Crystal Reports without first ensuring that it is fully 
tested and certified as compatible with GIFTS Alta.

MicroEdge’s experience to date has been that most custom reports convert 
without any problems. When report adjustments are required, they have 
proven to be relatively simple when made by technical staff with expertise in 
Crystal Report design and testing. Examples of these differences include 
skipping blank lines and the omission of totals.

Important: Be sure to review and test all of your custom reports when you 
upgrade to a new version of Crystal Reports. You should also test all custom 
or modified reports created by MicroEdge.
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